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Register 2: INTErTUPE SEATUS REGISTEN .....ucruerrirrsirsirississserssirissesssesssssissesssssssesssssassessssesssssisssssssesssssassessssssssssassses
Bus control [0St iNterrupt.......ecreecnerersernsernns

Recovery/initialization interrupt...........
DOWNSETEAIMN INECETUDE .cov.orveirecrsiesseisssseesssisesisessscssseassssssssssssssasssssssasesssesssssssssssssssssssasesssessssssssssssssssssssssssssssssssssasssansss
Functional test interrupt
MULTIPLEXER / SWITCHES 67
PCA9540B/PCA9S542A/PCAISA4A /PCAOTSAT .eererrerrserrnssssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssss 68
(001110 0] B £T e L R =) O .68
INECITUDES..ccvoceeereirretseesersirsirssrsissseisssssssss s s sssssssssssssans .. 68
Multiplexer CONLIOl....eeereeseerreresiris eeerenees s sena s ennes 69
AUEO WITIEC couereverssteeevsstseuesistsssssssssssssssssssssssssssssassasssssssasssssssassassssassasassassasassassasassassnssssassussasassussassnsasssssssassassssassassssassanes 69
PCA9543A/PCA9545A/PCA9546A /PCAISABA/PCAOSAT ....eerrrernrisseisssesssssssssssssssssssssssssssssssssssssssssssass 70
Control Register .
D= ) 2T
(00 10 L =] Y] =0 o o ) £ O 70
AAUEO WITIEC courreeeerssteeetsstseusssstsssssssssssssssssssssssssesssassassssassasssssssassassssassasassassasassassasassassnssssassassasassassassnsasssssssassassssnsassssassanes 71
NON-VOLATILE REGISTERS 72
PCA8B550/PCA9559/PCAIS560/PLAIGSOT ...ceerreerrrersserssessssssssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssss 72
Address SeleCtioN .........wwveevvevvsvessrsssssssssssssssssens w72
Data ReGiSter.....ironersnsensirnerens w72

EEPROM BYte X..ovvverververssernsenssssssesansns w72

MUX_OUT...... .72
W Lo A 73
REAL-TIME CLOCKS 74
PCEFBSB3 ..oooeeeueeeueesseesssesssssessssses st ss et ss s ss s8R R8RS 88 R AR R 1R R E RS ES R e 74
THERMAL MANAGEMENT 75
LM75A DIGITAL TEMPERATURE SENSOR AND THERMAL WATCHDOG....ccueueuresesssssessessessessessessssssssssssssessessesssssssssassane 76
DEVICE AAATESS ..overirererreriseerssirserissesssssissesssssissssassessssssssssassesssssassssssssasees w76
Automatic Write (CRECKDOX)........ocrirmecrirernsersesrissernssasessassesssssessesans w76
L L= -V OO w76
ReAd All..oueeeeerrrerrrerrsrerrssernsirnnns w76
Temperature Register (Temp)....... i 77
TRYSE (HYSEEIESIS) REGISLET ...vverveereerioeerisssesisssesisssesisesesasssesasasesssssessssssssssesssssssassssssssssssnsssssnsssssnsssssnssssssssanssssanssssanss 77
TOS (Overtemp shut-down tRreSROIA) REGISLOT ........cvceuorcerorserrsserisssrissessisssesisssesissssisssesisssesisssesisssessssesssssesinns 77
Configuration Register
SEATE ROAA BULEON cccouveeeererereseraeriseesasesassesssssassesassesssasassessssessssssssesssssssssssssssssessssssssssssssssssessssssssesssssssesansssssesassssssssasesans
NE1617(A) TEMPERATURE MONITOR ..cuecuueesseeesseessesssessssessssssssessssesssessssesssessssassssssssassssssssassssessssssssassssssssassssassssssssasssssssss 78
Read-Only Registers
WWITEE ONLY ROGISTCTS couuerereereeeerisesesissesissesisssesisssesasssesasesesasasesssssesssssessssssssssssssssssassssssssssssssssssssssssnsssssnsssanssssansssssnssssanss
W oI

SA56004A TEMPERATURE SENSOR....

SE98 TEMPERATURE SENSOR.....ccvuveunee
SLAVE MODE 81
WWTIEE E0 SIAVE.aueeeesevererieeersissstsissssssessisssesssssssssssssisssssssssssssessssssssssssssssssasssssssssssssssssssssasssssssssssssssesasssssssssssssssssssssssssesns 81
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REAA fIrOM SIAVE.......coooeerirseriiserissserisseesisssssisss s s ssssasssssasesssssessssssssasssssssssssssssssssssessssssssssssssssssssssssssnssssnssessnesesanesesanises 82
ENGDIE SIAVE..co.coueriiirssiivssiirssivsssirisssisisssisisss s ssisis s s ssesissisasssss s sssssssssss s s ssasss s ssssasssesssssssssssesssssenss 82
Define Slave Size........eoreonrcrerercresrnnes 82

Fill SIaVe BUffer....oeereronscrserissensnns 82
Read Slave Buffer... .82
Idle Slave............. .82
Resume Slave....... w82
Enable Master ..... .83
(00 [ X =2 83
TROUBLESHOOTING 84
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12C Protocol

General Characteristics

The I?C protocol allows data to be transferred between devices using two open-drain (or open-collector) bi-
directional lines. One line is the serial clock (SCL) and the other is the serial data (SDA). The bus master
generates the Start conditions, the clock signals on SCL, as well as the Stop condition. An acknowledge is
transmitted on the bus after each byte is sent over the bus.

Bit Transfer

Data on SDA must be stable while SCL is high. The state of SDA when SCL is high determines the logic level of
the transmitted data bit.

Start and STOP Conditions

Within the procedure of the I2C bus, unique situations arise which are defined as START and STOP conditions.
A HIGH to LOW transition on the SDA line while SCL is HIGH is one such unique case. This situation indicates
a START condition. A LOW to HIGH transition on the SDA line while SCL is HIGH defines a STOP condition.
The master always generates START and STOP conditions. The bus is considered to be busy after the START
condition. The bus is considered to be free again a certain time after the STOP condition.

" r—"

N AL N

12C Address

The first seven bits of an I°C transmission make up the slave address. The eighth bit (or the least significant
bit) is the R/W bit that determines the direction of the message.

MEE L3

T T T T 1
| 3
1 1 1 1 1 1

I— Ehave mﬁ4|

A '0'in the least significant position of the first byte means that the master will WRITE information to the
selected slave. A '1" in this position means that the master will READ information from the slave.

When an 1?C address is sent, each device in a system compares the first seven bits after the START condition
with its own address. If they match, the device considers itself addressed by the master as a slave-receiver or
slave-transmitter, depending on the R/W bit.

When selecting addresses within USB-to-12C, the software assumes the least significant bit is zero (write). If
the I?C message is a write transmission, the least significant bit will be sent as a ‘0’ while if it is a read, the
software will append a ‘1’ in the LSB position.

12C Bus Documentation

The complete I2C Bus specification can be found on the NXP Semiconductors website.



Main Screen

This user manual covers the features of the USB-to-12C software, for the USB-to-12C Professional, Elite, and
Ultra hardware. The software for each hardware has similar features, however, the USB-to-12C software for
the different hardware platforms are not compatible, so if you are using both hardware platforms, you will
need to install the Professional, Elite, or Ultra software packages.

When the USB-to-12C program starts, a screen, as shown below, will be displayed on the monitor.

USB-to-12C Elite o o S
File Device Options Window Help
Device Menu Options Menu
USB Hardware I2C Frequency
Indicator
Output Power
Message Panel e Frestare
Hardware Detected 3.3V On 5.0V On 400 kHz

Device Menu

The device menu contains a list of I°C devices supported by the USB-to-12C software. Selecting the device
from this menu may start any of the listed devices. You can have any combination of devices open at one
time. Switching between active devices may be accomplished via the Window menu on the main toolbar.

Message Panel
The main screen has a panel that displays messages from the program. It will indicate if the I>C transmission
was successful or if there was a problem encountered. A list of messages is shown below.

Messages:

Transmission successful - the last I°C transmission was successfully completed.

Address not acknowledged - an I°C address was successfully transmitted but no slave device acknowledged
the address. A STOP condition is sent after the acknowledge clock pulse if no acknowledge is received.

Data not acknowledged - an I°C address was previously acknowledged but one of the following data bytes
was not acknowledged. . A STOP condition is sent after the acknowledge clock pulse if no acknowledge is
received.

Read acknowledged corrupted - the master tried to send a NACK (no acknowledge) for the last read byte in
a transmission, but it was corrupted by a low level on SDA by another device on the bus.

SDA stuck low - before a START condition is initiated, the software verifies that both the SDA and SCL lines
are high. If SDA is stuck low, then an SDA stuck low message will be displayed.

SCL stuck low - before a START condition is initiated, the software verifies that both the SDA and SCL lines
are high. If SCL is stuck low, then an SCL stuck low message will be displayed.
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Hardware not detected- is displayed when there is no USB-to-12C hardware plugged into the PC’s USB port,
or if the drivers are not installed correctly.

File Menu

Upon starting the USB-to-12C software, the File menu contains the Exit and Close commands. When a device
has been selected from the Device Menu, it is possible that the File Menu will also display device specific
commands such as Save As and Load. In User Device mode, previously created device files may be
conveniently loaded.

Save Data
Many devices contain the menu item 'Save Data' under the File menu. The data may be recalled by selecting
the Load Data item under the File Menu.

Load Data

After data has been stored using the 'Save Data’' item in the File menu, it can be recalled by selecting the Load
Data item.

Options Menu

The options menu allows you to change the 1°C frequency, the 3.3V and 5V power outputs are also controlled
from this menu. If you have multiple USB-to-12C Elite, Ultra, or Professional hardware units connected to
your PC, you can select which device you would like to communicate with.

i =

USB-to-12C Elite o S

File Device | Options | Window Help

=

£f I'C Frequency (T)

Ii Enable 3.3V Output Power
'i Enable 5V Qutput Power

Ignore Acknowledge

@ | 5N4033

Hardware Detected 3.3V On 5.0V On 100 kHz

I2C Frequency Menu Item

The I2C frequency dialog box can be activated by:

H I*C Frequency Elﬂlﬂ—hJ a. Selecting I°C Frequency in the Options menu

b. Double-clicking the frequency indicator on the bottom
right corner of the application
250000 Hz C. Right-clicking the status bar at the bottom of the

application, and then selecting 1°C frequency

By choosing this menu item, you will activate a dialog box that
SCL High 300 = shows the current I2C frequency.

00 = The frequency can be changed by entering a value into the edit
SCL Low i box. Pressing the OK button will close the dialog box and will
update the I2C frequency panel on the main screen.

The SCL High and SCL Low spin controls allow you to fine tune the
frequency and also allow you to control the duty cycle of the clock
ke signal.

4

OK
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Enable 3.3V Output Power

By selecting the 3.3V Output Power menu item, the USB-to-I12C hardware will supply power to your target
system. There is no need to enable this output unless you need to power your target system. When enabled,
there will be a checkbox beside the menu item and the status bar at the bottom of the application will have a
3.3V On indicator shown in green.

Enable 5V Output Power

By selecting the 5V Output Power menu item, the USB-to-12C hardware will supply power to your target
system. There is no need to enable this output unless you need to power your target system. When enabled,
there will be a checkbox beside the menu item and the status bar at the bottom of the application will have a
5.0V On indicator shown in green.

Windows Menu

The Windows Menu contains screen commands such as cascade, tile, arrange all icons, and minimize all. If
there are devices active in the program, you will find them listed in this menu. When multiple device types
are open, it is easy to move between the device types by clicking on the desired item in this menu.

Frequency Indicator

The frequency at which the hardware is sending 1°C messages over the i2c bus is shown in this box on the
main screen. Note that the hardware cannot produce every value you enter so it will set it to the closest
available frequency.
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Supported Devices

USB-to-12C software version 7.1 supports the following devices:

Generic I12C Devices (non- PCA9556 PCA9553

specific) PCA9557 PCA9622

Expert Mode PCA9574 PCA9624

User Definable Mode PCA9575 PCA9626
PCA9670 PCA9632

EEPROM/RAM/FRAM PCA9671 PCA9633

128 bit (16 bytes) PCA9672 PCA9634

1k bit (128 bytes) PCA9673 PCA9635

2k bit (256 bytes) PCA9674 PCA9685

4k bit (512 bytes) PCA9674A SAA1064

8k bit (1k bytes) PCA9675

16k bits (2k bytes) PCA9698 12C Master Selector

32k bits (4k bytes) PCF8574 PCA9541

64k bits (8k bytes) PCF8574A

128k bits (16k bytes) PCF8575 Non-volatile Registers

256Kk bits (32k bytes) PCA8550

512k bits (64k bytes) 12C Multiplexers and PCA9559
Switches PCA9560

10 Expanders PCA9540B PCA9561

PCA9536 PCA9542A

PCA9537 PCA9543A Real-Time Clocks

PCA6408A PCA9544A PCF8563

PCA8574 PCA9545A

PCA8574A PCA9546A Temperature Sensors

PCA9500 PCA9547 LM75A

PCA9501 PCA9548A LM75B

PCA9502 PCA9549 NE1617(A)

PCA9505 PCT2202

PCA9506 LED Drivers PCT2075

PCA9534 PCA9530 SAA56004

PCA9535 PCA9531 SE97

PCA9538 PCA9532 SE97B

PCA9539 PCA9533 SE98(A)

PCA9554 PCA9550

PCA9554A PCA9551

PCA9555 PCA9552
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Memory Devices (EEPROM, RAM, FRAM)

Upon starting any memory type device, you will see a screen similar to the one shown below. Note that
RAM/FRAM will be similar to EEPROM, but it will not have a Page Size or Write Time.

F i ™
USB-to-12C Elite—[C:\USE—to—I2CEIite.bin- - (i 0 e S
& File Edit Device Options Window Help
0 |1 (2 |3 |4 |5 |6 |7 |8 [9 |a|B |C (D |E|F 01234567 89ABCDEF
Device Sze 256 0O 00 01 02 03 04 05 06 O7 08 09 OA OB OC OD OE OF
Address AEIEIl101112131415161?18191A151C1D1E1F . . . .
Page Size 3252312122232425252?23332512025} 1 " Fd%& () T4, - . ]
I S :3303132333435363?38393A.383C31].3E3= 0123456789 :; <=53?7
4 40 41 42 43 44 45 46 47 48 49 4A 4B AC D £ I @ABCDEFGHI 1KLMND
Byte Address=0x000 5 |50 51 52 53 54 55 56 57 58 59 SA 5B 5C SD SE SF PQRSTUVWXY Z[ V] _
Read Byte 6 60 61 62 63 64 65 66 G7 68 69 GA 6B GC 6D GE GF “abcdefghijkl mno
ez 7 |70 71 72 73 74 75 75 77 78 79 OFAB MDD FE T pgrstuvwxyz{]}~
8 80 81 82 83 84 85 86 87 83 89 8A 8B 8C 8D B8E &F
site bvie 9 90 91 92 93 94 95 95 97 98 99 9A 9B 9C W SE 9 .
' A 53 42 20 53 6F GC 75 74 69 6F GE 73 2C 49 GE 63 SBE Solutions,Inc
B 77 77 77 X 69 32 63 74 6F & 6C 73 JE 63 &F 6D ww. i 2ctoel s.com
€ 55 53 42 2D 74 6F 2D 49 32 43 20 45 6C 69 74 65 USB-te-I12C EIite
Fil from 00 DR D 0 2D 20 D D D D D D I D XD WD XM - - - - =S s oo e o i
e = E 49 32 43 20 4D 61 64 65 20 53 69 6D 70 6C 65 20 I1 2C Made 5impl e
F FO F1 F2 F3 F4 F5 F6 F7 F& F9 FA FBE FC FD FE FF
Fil with  FF
Fill Buffer
Copy from Copy to
00 7F 80
Copy Block
Transmission successful Hardware Detected 3.3¥ On 5.0V On 100 kHz

= |

-
USB-to-12C Elite - [CAUSB-to-12C  12C Address
% BilerEdit=BevicerByplions A drop-down menu is provic.led which allows the user to select a valid
= address for the selected device type.
L/
Device Sze 256 0 00 01
Address AE] E 1 10 &
Page Sire AD 2
A2 3 30 3
Write Time |A4
AG 4 40 4
Byte Address= A8 5 50 51
AA ]
Read E"Jﬁtc 6 60 &2
7 |70 7
Resd A
8 80 &
L Write Bvte —— [

USB-to-12C Software User’s Manual Page 14



USB-to-I2C Elite - [CAUSB-to-12C

8 File Edit Device Options

0 1
Device SEe 256 0 00 0:
Address  AE [v] |1 (10 I
pagesze 32 [¢f] |12 2 F
3 30 X

Write Time |1
8 4 40 &
Byte Address 5 50 5:
REad 6 80 &
7 |70 T

Read All
B 80 &
Write Byte 9 90 g
Write All A 53 &

USB-to-12C Software User’s Manual

Write Page Size Selection

The Page Write Size defines the number of bytes that may be written
in a single erase/write programming cycle. Smaller devices generally
use an 8 or 16-byte pages while larger devices use up to 128 bytes per
page. Check the device datasheet to find the appropriate page write
size for the device you are programming. If you do not know the page
size, use a small page size such as 8 bytes. A smaller page size will
require a longer total programming time for a device.

Erase/Write Cycle Time

Programming software must allow a certain period of time to elapse
after writing a block of data to an EEPROM. This time is device
dependent but is normally between 5ms and 40ms. A STOP condition
must be performed before the erase/write cycle commences. Most
EEPROMs will not respond to their address until the erase/write cycle
has been completed.
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USB-to-12C Elite - [CAUSB-to-12C Data Grid

% File Edit Device Options The data grid consists of rows and columns. Each cell within the grid contains a two-

digit hexadecimal number. Each cell corresponds to a physical byte location within the

: : 2L memory device. For example, in the diagram below, cell 0x21 is highlighted (row 2,
Device Sze 256 0 00 0 . lumn 1).
Address ~ AE [¢] |1 10 1
Page Size 32 IZI 2 20 2 Thjs translates to address 33 (decimal) in the device. The program calculates the
Write Time |5 = |# |30 3 physical address for you and displays it at the left side of the screen in the box labeled
' |4 'ag & ‘Word Address’ or ‘Subaddress’.
Byte Address=0x000 |5 50 5= Byte Address (Subaddress)
Read Byte 6 80 & The byte address (sometimes called subaddress or word address) is a pointer to a
7 70 7 register or memory location within the I°C device. To access this location, the software
aead Al 8 an g Willsendoutthe device I2C address, followed by this byte address, followed by the read
Write Byte S oo g' or write data. The program displays the byte address of the active cell of the memory
grid in both hexadecimal and decimal notation.
Wirite All A |58 %
=1L ® 7 7 Read Byte Button
C s Pressing the 'Read Byte' button initiates a read from the I*C device. The program
Fill from 00 D 2D Z pegins the transmission by writing the device address, followed by the current byte
: E 43 3. address. A Repeated Start is then generated, followed by the device’s read address, and
Fill to id F ro p finally aread of a single data byte. The result of each byte read is immediately entered
Fill with FF in the appropriate cell in the grid. Alternatively, you may press the <Alt> and <b> keys
simultaneously to achieve the same results.
e Read All Button
Pressing the 'Read All' button initiates a read from the 1C device. The program begins
Copy from  Copy to the transmission by writing the device address, then the byte address 0x00. A
oo 7F 80 Repeated Start is then generated, followed by sequential reads of the entire device. In
addition to pressing the 'Read All' button, you may press the <Alt> and <r> keys
Copy Block simultaneously to achieve the same results.

Transmission successful Write Byte Button

Pressing the 'Write Byte' button initiates a Write to the I°C device. The program begins
the transmission by writing the slave address and then the word address of the currently active cell in the
grid. The selected data byte is then sent. In addition to pressing the 'Write Byte' button, you may press the
<Alt> and <y> keys simultaneously and achieves the same results.

Write All Button

Pressing the 'Write All' button initiates a Write to the 1°C device. The program begins the transmission by
writing the byte address 0x00 to the device and sequentially writes the entire device.

For a RAM type device, the data is sent in one long message. In the case of an EEPROM, the software will send
one page of data (usually 8 bytes but check the datasheet for the particular device you are addressing)
followed by a STOP condition. Following the STOP condition, the program waits a length of time, determined
by the Erase/Write cycle time of the device (again check the datasheet for the device you are programming),
before writing another page to the device. In addition to pressing the 'Write All' button, you may press the
<Alt> and <w> keys simultaneously to achieve the same results.

After completion of the write cycle, the USB-to-12C software will read the entire device to verify that the
contents of the device match the data that was sent. An error message will be displayed if the data read from
the device does not match the data in the on-screen buffer.
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Verify Button

Pressing the ‘Verify’ button initiates a read of the entire EEPROM. After reading the contents of the EEPROM,
USB-to-12C will compare the contents with the values in the grid. An error will be flagged if the contents of

the EEPROM do not match the contents of the USB-to-12C on-screen grid.

-

USB-to-I2C Elite - [CAUSE-to-12C Elite.bin]

&Eile Edit Device Options Window Help

012 3 45 6|7 89 A B C DIE
Device Sze 256 0 00 0L 02 03 04 05 06 07 03 09 OA 0B OC OD OE
Addrass AE E 1 |10 11 12 13 14 15 16 17 18 19 1A 1B IC D I
Page Sze 32 B |2 |20 00 00 00 OO0 OO 00O OO OO0 00 00 0O OO
Wite e |5 = 00 00 00 OO OO 00 OO OO0 00 00 0O 0O OO
4 00 00 00 OO OO 0O OO OO0 00 00 0O 0O OO
Byte Address=0x021 |5 00 00 00 00 OO OO0 0O 0O OO OO0 OO 5D SE
Read Byte 660 61 62 63 64 65 66 &7 63 69 8D 6F
s F (707172 374 75 3 77 74 78 7C D E
B0 81 82 83 84 85 86 89 8A 8B BC SD SE
siietvic 90 91 92 93 94 97 93 99 SA 9B 9C 9D OF
Write All 53 6C 75 74 69 6F 6E 73 2C 49 6F
Verity 2F 69 32 63 74 6F 6F 6C 73 ZE 63 &F
D 74 6F D 49 32 43 20 45 6C 69 74
Al from 21 M I WM MM MDD MDD
=i = 20 40 61 &4 65 20 53 69 6D 70 GC &5
F |[FO F1 F2 F3 F4 F5 F6 F7 F8 F9 FA FB FC FD FE

Fill wwith 0o

Fill Buffer

Checkerboard

F
OF
IF
0o
0o
0o

Fill Buffer

The grid will be filled with
the two-digit hexadecimal
number found in the ‘Fill
with’ edit box when the Fill
Buffer button is pressed.
The fill can be constrained
to the addresses found in
the ‘Fill from’ to the ‘Fill to’
edit boxes. No information
will be sent over the I2C
bus.

The grid will be filled an alternating ‘1’ and ‘0’ pattern when this is chosen from the Fill with Checkerboard

selection is made on the Edit menu.

Inverted Checkerboard

The grid will be filled an alternating ‘0’ and ‘1’ pattern when this is chosen from the Fill with Inverted
Checkerboard selection is made on the Edit menu.

Hexadecimal |3FFE]

shown.

Decimal 16382

Cancel

64

Mote: maximurn address = 0x7FFF

USB-to-12C Software User’s Manual

Go To Byte...
When the Go To Byte menu selection is made from the Edit menu, a dialog
box is displayed where a hex or decimal address may be entered. When
the OK button is pressed the grid location with the desired address is

This is useful when you don’t want to scroll through to find a specific data
location.
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use o2 et C\USE eBc e (NN Copy Block

% File Edit Device Options Window Help
4 5 6 7 8 9 A B C D E F
Device Size 256 04 05 06 07 08 03 OA 0B OC OD OE OF
Address AEE| 14 15 16 17 18 19 1A 18 I1C 1D 1E IF
Page Size 325 24 25 26 27 28 29 ZA B I M XE F
WiteTime |5 B 34 35 36 37 38 39 3A 3B 3C 3ID 3E IF
44 45 46 47 48 43 4A 4B 4C 4D E 4
Byte Address=0x000 54 55 55 57 58 53 SA 5B 5C SO SE 5F
Read Byte 64 65 66 67 68 69 GA 6B GC 6D 6E G&F
T 74 75 76 77 78 79 7A 7B 7C T TE.TF
04 05 06 07 08 03 0OA OB OC 0E OF
e Bvie 15 17 18 19 D E IF
Write All 25 27 28 B L M E F
Verify 35 37 34 38 3C 30 3E 3F
44 4B 4C 4D 9E 4
Fil from #21 55 5A 58 5C 50 SE S5F
Fill to sC SRR R SO e
79 7A B IC M E F
Fill wyit an
ill Buffer
Copy Block
Transmission successful Hardware Detected 3.3V On 5.0V On

USB-to-12C Software User’s Manual

It is possible to copy a block of data
from one on-screen buffer area to
another using the Copy Block function.
Simply define the data to be copied
using the ‘Copy From’ edit boxes and
then enter the address where the data
is to be copied to. The ending address
is calculated automatically by the
software and is not editable by the
user. Pressing the Copy Block button
starts the copying process.
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Open EEPROM File

Look in: | (. EEPROM

=

Recent

o

Dezklop

\$

My Documents

=

= 5

[ 1
& &

h=)

=

g

Fdy Metwork
Places

- emekE-

2566 EE.mem

File hame: |

=

Files of type: ]mem files [* mem]

|

Open |

Cancel ] .

mer files [*.mem)

USB-to-12C Software User’s Manual

hex files [ hex]

biry files [* bin)
cav files [" cav)

Open and Save Data

Data can be saved for later use in
one of four formats:

mem: this format places the raw
data in a file (similar to a bin file)
but also saves the device
configuration (device size, address,
page size, and write time).

hex: standard Intel hex file format
bin: binary file.

csv: comma separated variables
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Universal Interfaces

User Definable Device

The User Definable Device allows you to define your own I*C device and then enables the user to change the
values of the individual cells within the grid using various controls such as sliders and spin controls.

USB-ta-12C Elite - [SAAT120] =ren X
% File Edit Device Options Window Help - | & x®
Address (hex) 0x5A: Chrominance phase

AE o 1 2 3 4 5 & ¥ B % A B C D E F
. Dx54 [=] | 0x75 (=]
0 00 00 OO OO0 OO OO OO0 OO OO0 00 00 OO 00 OO 00 00
Write 1 00 00 0O 0O 0O OO OO OO OO0 00 OO OO0 OO0 00 00 00
2 (00 00 00O OO0 OO0 OO OO OO0 0O OO0 QOO OO0 OO OO 00 00
geal e 3 00 00 00 00 00 DO 00 00 0D 00 29 00 00 00 00 00 ||
4 (00 00 OO OO0 OO OO OO0 OO OO OO0 QO OO 0O OO 00 0O E =
= [ [=% =
|”| Byte Mode 5 |00 00 00 0O OO0 OO OO 00 00 00 89 OB OA 00 00 00 o) =
o
i 6 00 00 OO0 OO0 OO OO OO0 OO0 OO0 00 00 OO0 00 OO0 00 19 % g
Wirite All | c 5
7 |00 00 OO 0O 00 A6 OO OO0 OO OO0 OO OO0 0O OO 00 00 E E
Read Al ' =
0x6F [=] || 0x5B (8] 8]
Create Control =
: 00011001 i
Slider -
[#] Auto write On [¥] Auto write On
s2i Closed caption, Teletext enable Gair U
- [¥] Buto Write On ' [¥] Buto Write On |
| i 0x3A [&] | 0xs¢ (5]
00101001 A .
[¥] Auto Write On [¥] Aute Write On
Input port control Gain ¥
l& Hardware Detected 3.3V 0On 5.0V On 100 kHz

= =

When the User Definable Device is first opened, a 256 byte device grid is shown on the screen but does not
have any names associated with the data, and all the data bytes are set to 0xFF. A previously defined device
may be loaded by selecting it from the Most Recently Used files at the bottom of the File menu. If devices have
not yet been defined, there will be no devices shown below the File/Exit menu item.

To begin the definition process, you may right click with your mouse on any data cell in the grid or select
'Current Device' or 'Current Cell' from the Edit menu. The Reset item in the Edit menu will clear all the
register names to 'Undefined Register' and set the data values to 0xFF.

Clicking on the desired cell and doing one of the following can change the data value of the individual cells:
1. Typing in a two-digit hexadecimal number.

2. Assigning a slider to the active cell by pressing the Slider button.

3. Assigning a spin control to the active cell by pressing the Spinner button.

4. Assigning a Bit-wise control to the active cell by pressing the Bit-wise button.

Items 2, 3, and 4 can also be achieved by positioning the cursor over the desired cell and right clicking on the
grid to select the appropriate control from the pop-up menu.
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Define New Device

This is similar to the Edit Current Device (explained below). This menu selection allows the user to start a
new device from scratch. All register names are undefined, and all default values are OxFF.

Open Device Definition File

A previously saved device definition file (.def) can be recalled by selecting this menu item. The device
definition file contains the Device Name, Device Address, Register Names, and Register Values.

Save
Device definition files can be saved to disk by selecting the Save menu item.

Save As...

Use the Save As dialog box to change the definition file name or to save the definition file in a new location. If
the file name already exists, USB-to-12C asks if you want to replace the existing file.

Save Registers in text format
The device definition files are not in a format that can easily be used by the user, therefore, USB-to-12C allows
you to save the information in a text format (extension .txt). Users can then open and edit this file with any

word processor such as Notepad or WordPad. The text files are for the user’s information only and cannot be
read by USB-to-12C.

Byte Mode

When the Write All and Read All buttons are pressed, the software assumes that the subaddress is auto-
incremented after each data byte is written or read. For example, if you have a four-byte device, the writing
sequence would be Start-Address-Subaddress0-data0-datal-data2-data3-Stop. Many devices do not auto-
increment the subaddress between data bytes and require that only one data byte is sent for each
transmission. In these situations, click on the Byte Mode check box. The writing sequence would be Start-
Address-Subaddress0-data0-Stop. The sequence would be repeated for each data byte.

Print Device Data
A print out of the register definitions can be obtained by selecting this option from the File menu.

Data Grid

The grid consists of rows and columns. Each cell within the grid contains a two-digit hexadecimal number.
Each cell corresponds to a physical byte location within the I2C device. For example, in the diagram shown
above, cell 0x07 is highlighted (row 0, column 7). This translates to address 7 (decimal) in the device
(assuming the first byte is address 0x00). The data may be changed by entering hexadecimal numbers from
your keyboard. Non-valid keys will be ignored. In order to edit the entire grid, including the name and
default values of the registers, you may right click on the grid or select the appropriate item from the Edit
menu.

The individual cells within the grid will be blue if the cell's subaddress is greater than the maximum number
of registers defined for the active device. The number of device registers may be changed at any time in the
‘Edit Current Device’ screen.

Edit Menu

The Edit menu is available only when the User Definable Device screen is active.

The user can select from one of the three menu items:

1. Current Device - brings up a screen showing the all the register data for the active device.

2. Current register - allows registers to be changed one at a time.

3. Reset grid - all register data will be set to OxFF and the register descriptions will be 'Undefined Register’
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H Edit Register

ESEE)

Register Ox07
Intial Value (hex): EQ

Description | Horizontal sync stop

OK Cancel

Edit Current Device

Edit Current Register

If you want to adjust one register in the grid, use the 'Edit
Current Register' screen. This screen can be started by right
clicking on the User Definable Device grid or by selecting
Current Register from the Edit menu. The name of the register
and the initial value displayed, when the definition file is first
opened, can be changed here. Note that the register name
changes are not saved until the ‘Save’ or ‘Save As..." item
(under the File menu) is selected.

L

rE Edit Current Device l = | (=] |_i2-r
Device Name: SALT120
Device Address: AE  Numberof  qoglal g gp
Registers (=

Register Description
00 Test
o1l 00
02 Mull 0o
03 Mull oo
04  ull 0o
05 Mul Qo
06  ull 0o
07 Horizontal sync stop EO
08 Ml ua]
09 Mul oo
oA Mul 0o
iR Rluall N

Ok Cancel

transferred to the User Definable Device screen.
Cancel button: the editing session will be closed and no changes to the User Definable Device screen will
occur.
Note that any changes are not saved until the ‘Save’ or ‘Save As..” menu item is selected.

USB-to-12C Software User’s Manual

Editing the current device may be
accomplished by clicking on 'Edit Current
Device' from the Edit menu, or by right
clicking on the grid within the User
Definable Device mode of USB-to-12C. The
screen, shown above will be displayed
when either method is invoked.

Device Name: the name entered in this box
will be shown in the title bar of USB-to-12C
when the definition file is opened.

Device Address: is the device I°C address
that will be displayed in the Address box
when the definition file is opened. Note
that only even addresses are valid here.
USB-to-12C will append the appropriate
R/W bit at the end of the address
depending upon the operation to be
performed (the last bit will be a '1"if itis a
read operation and a '0" if it is a write).
Number of Registers: Enter the number of
registers the device contains. The size of
the data entry grid will be modified to
accommodate the number of registers.
Fill: This box should be modified only if
you want to initialize all the registers to one
particular value.

OK button: the data entered by the user in
the 'Edit Current Device' screen will be
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Slider Control

The Slider Control is activated when the user presses the Slider button
on the User Defined Device screen or by right clicking the grid and
then selecting 'Change Active Register with Slider Control' from the
pop-up menu.

Reqister
Subaddress

Reqgister

Descriptinn\

The subaddress of the active cell in the grid will be assigned to the
Slider. The subaddress is shown in the upper left corner. Moving the
slider bar up and down will cause the value of that cell to be changed.
If Auto Write On is checked, then the contents of the cell will be
transmitted to the device subaddress when it is changed. If an error is
encountered while transmitting using Auto Write, USB-to-12C will turn
off Auto Write and it will be up to the user to fix the error condition
and re-enable Auto Write.

It should be noted that the Slider Control always stays on top of all
other devices within USB-to-12C.

5

Luminance brightness

Automatic
\Write
Selection

Spin Control
The Spin Control is activated when the user presses the Spinner button on the User Defined Device screen or
by right clicking the grid and then selecting
Reqgister 'Increment/Decrement Current Register with a
Subaddress Spin Control' from the pop-up menu.
The subaddress of the active cell in the grid will
be assigned to the Spin Control. The

Reqister value

{decimal) Register subaddress is shown in the upper left corner.
walue thexd | Clicking on the spin control's up or down arrow
— :
Autaomatic ] Auto Wiribe OFf will cause the value of that cell to be

Write Selection Harizonkal sync stop Reqister incremented or decremented. If Auto Write On

Description | s checked, then the contents of the cell will be
transmitted to the device subaddress when it is

changed. If an error is encountered while transmitting using Auto Write, USB-to-12C will turn off Auto Write

and it will be up to the user to fix the error condition and re-enable Auto Write.

It should be noted that the Spin Control always stays on top of all other devices within USB-to-12C.

Bit Control
The Bit Control is activated when the user
Register presses the Bit Control button on the
Subaddress User Defined Device screen or by right
|ET|EI_|1_|1_|EI_|EI_|1_ |1— Fiecjatier Walie clicking the grid and then selecting 'Use
s 1 inEBinary Bit Control to Change Active Register
erite .| futo Write OFF from the pop-up menu.
Selection - !
Esen R CORtia s e T — Egglzsr'i:;triun The subaddress of the active register in
the grid will be assigned to the Bit
Control. The subaddress is shown in the

upper left corner. Clicking on any of the
eight edit boxes will cause the value of that bit to be inverted. If Auto Write On is checked, then the contents
of the cell will be transmitted to the device subaddress when it is changed.
It should be noted that the Bit Control always stays on top of all other devices within USB-to-12C.
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Expert Mode

The figure below shows the Expert Mode screen.

Delete a row

Clear the Copy the
add a row active row  active row Paste data
Open new USB-to-12C Eh{e r Ex er/Mude R
blank pagﬂ\\ [ P 1 g@.
& File Edit Devicey, © tla ydg/:éf/ — | &

Open _J_@ H ﬁ
datafile I'j,sg‘ﬁ"- Stprf Addressl R/ |Data |5I:up |Delay|Nntes [
Save / 1 ST AE Wite 00,01,02,03 4 05, EIIS 07,03 Yes Write 8 data bytes ko eeprom with 10ms write cycle
data ,2/ ST AE Write 00 Send subaddress 0x00 to eeprom

3 ST AE Read 01,02,03,04,05,06,07,05 Read & bytes from eeprom
Close / 4 ST
Expert
Mode 9 ST Compress the data lgnore

6 ST acknowledge

T ST

B8 5T

9 5T

10 5T
send 11 sT -
Message - (|
Button ™ Sand Message Send all Send Sequence | | Send Continuously
Active .. Ackive Msg, =8 Sending Msg # 3 01,02,03
?nedﬁif::gsr Transmission successiul Hatdware Detected 3.3¥ Off | 5.0% OFf 100 kHz

! T N !
Send All Send Sequence gequence Send Continuosly
Button Button Indicator Button

Open New Page

Pressing this button opens a new blank page. There will be 8 empty rows (messages). Selecting ‘New’ from
the ‘File’ menu while the Expert Mode is active will perform the same function.

Open Data File

A previously saved data file can be recalled by pressing the Open Data File button or by selecting Open from
the File menu while the Expert Mode is active. A dialog box will be displayed allowing the user to navigate to
the appropriate directory.

Save Data

The current data will be saved when this button is pressed. The user specifies the name and location of the
file in a dialog box that is displayed after the button is pressed. A dialog box will be displayed which allows
the user to navigate to the appropriate directory.

The user can also perform the same function by selecting Save from the File menu while the Expert Mode
screen is active.

Close Expert Mode
The Expert Mode screen is closed but USB-to-12C will not be terminated.

Add a Row

Inserts a new (blank) row after the active row. You can also use the Ctrl+Insert keyboard shortcut to insert a
new row. The total number of rows is limited to 64.
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Delete a Row
Deletes the Active Row (active message). You can also use the Ctrl+Del keyboard shortcut to delete the
current row.

Clear the current row
The current row (message) will be cleared. The row will not be deleted but will appear blank.
You can also use the Shift+Del keyboard shortcut to clear the current row.

Copy the Current Row

The current row (message) will be copied. Use the Paste command to paste it to a different row.
You can also use the Ctrl+C keyboard shortcut to copy the current row.

Paste Data

Previously copied data will be pasted into the current row (message).
You can also use the Ctrl+V keyboard shortcut to paste the clipboard into the current row.

Compress Data
All blank rows will be eliminated from the display. Here is an example of a display before compress:

UISB-to-12C Flite - [I:C Expert Mode] =Jo&d
ﬁ File Edit Device Options Window Help - | B X
JAEY| 4+ -2RBLH®
|Msg # |Stark Address| R/ |Data |5tup|DeIay|Nutes |
1 1) AE i Write 00,01,02,03,04,05,06,07,05 Yes 10 Write § data bytes to eeprom with 10ms write cycle
2 ST
3 ST
4 ST AE Write |00 Mo 0 | 3end subaddress 0x00 to eeprom
5 5T
b 5T
7 ST
8 ST
q aT AE Read 01,02,03,04,05,06,07,08 Yes 0  Read d bytes from eepram
10 ST
Send Message Send All send Sequence Send Continuousty
Ackive Msg, = 1 Done
Transmission successful Hardware Detected 3.3¥ Off 5.0¥ Off 400 kHz

And here is the same screen after the compress:
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UISB-to-12C Flite - [I:C Expert Mode] = 0td
% File Edit Device Options Window Help = || & =
JREB ||+ =22 B H®
Msg # | Stark Address| /W |Data |5top|DeIar|Notes
1 aT AFE  § Write 00,01,02,03,04,05,06,07,08 Ves 10 Write & data bytes to eeprom with 10ms write cycle
i aT AE Write | 00 Mo 0 Send subaddress Ox00 ko eeprom
3 sT AE Read 01,02,03,04,05,06,07,03 Yes 0 Read 3 bvtes from eepram
Send Message Send All Send Sequence Send Continuoushy
Ackive Msg, = 1 Cone
Transmission successful Hardware Detected 3.3¥ Off 5.0 OFff 400 kHz

It is not required to perform a compress, but it does speed up the message transfer process since the
application does not need to evaluate blank rows to see if there is data to be sent.

Send Message

The current message will be sent when this button is pressed. The current message number is shown below
the Send Message button. To change the active message to be sent, single-click on the row of the data to be
sent.

Send All

All the valid messages on the screen will be sent in order of the row number. The action will be performed
one time. A message is valid if there is a minimum of an address within the message.

Since the program tests for a valid message on each line within the message grid before sending the message,
itis recommended (not required) to compress the data (see Compress Data above) to speed up the transfer.

Send Sequence

A sequence of messages will be sent when the Send Sequence button is pressed.

The sequence editor is invoked by double-clicking on the sequence display. The sequence length can be up to
64 messages in length. The sequencer is limited to using messages 1 through 64.

The Sequence Editor is shown below.

HSequence Editor E]@-\

Sequencer
1 ‘2 |3 |4 |5 |5 |? |a |9 |ID|11|12|13|14|15|16|1?|18|19|20|21|22|23|24|25|26|2?|28|29|30|31|32

414

Message Editor

The i2c message cannot be edited directly in the Expert mode screen. Instead, an Expert Mode Editor is
brought up either by double-clicking on a message or when the user attempts to type directly into one of the
rows (messages) in the Expert Mode screen.
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Address AE Stop? Yes E|
Read/Write Write || Number of Bytes 9 : Close Editor

Delay After Message (ms) 10 =

Motes
Write 8 bytes to address 0xAE, subaddress 0x00

Write Message |
iz |z le. |s |6 |z 18 _lo

loo |01 02 03 04 05 06 07 08

Message Number
The message being edited is shown at the top of the message editor screen.

Delay after message
A delay, measured in milliseconds, can be inserted after a message.

Device Address

The 12C slave address is entered in the address box in hexadecimal notation. The least significant bit of the
address is not important (can be a ‘1’ or ‘0’) since the Expert Mode will ensure that this is appropriate for the
read/write transaction when the message is actually transmitted.

Read/Write Selection

The user can select a Read or Write transaction from the drop-down selection box. If a Read is chosen, then
the ‘Number of Bytes to Read’ box will be shown, and the data entry area will be hidden. If a Write is chosen,
the ‘Number of Bytes to Read’ will be hidden and the data entry area will be shown.

Stop?

Sending a Stop condition after a message is optional. Normally, it is advisable to send the Stop condition. Ifa
Stop condition is not sent, the clock line will be held low until the next message is sent. If a Stop is not sent,
the next message will begin with a Restart condition rather than a Start condition.

Message Data
The Message Data area contains the location where the user can enter up to 128 data bytes in hexadecimal
format. Blank data bytes will be ignored.

Notes
The information in the Notes section is optional, and is not used by the USB-to-12C software.
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|O Expanders

The USB-to-12C supports at least 32 10 Expanders.

File fm] Options Window Help

EEPROM

I/O Expanders PCAB5T4 8-bit1/0 Expander
LED Blinkers and Dimmers PCAB574A 8-bit /O Expander
Master Selector (2-to-1 demux) PCAB575 16-bit I/O Expander
Multiplexers/Switches PCA9500 &-bit1/O Port with 2K EE
Mon-volatile Registers PCA9501 8-bit1/O Port with 2K EE
RAM / FRAM PCAS502 8-bit I/O Expander
Real Time Clocks PCAS505 40-bit I/O Expander
Thermal Management PCAS506 40-bit I/O Expander
Universal Modes PCAD534 &-bit /O Expander
PCA9535 16-bit IO Expander
PCA9536 4-bit I/O Expander
PCAS53T 4-bitI/O Expander
PCAS538 &-bit I/O Expander
PCAS539 16-bit /O Expander
PCAD554 &-bit /O Expander
PCAS5544 8-bit /O Expander
PCA9555 16-bit IO Expander
PCA9556 &-bit1/O Expander
PCA9557 8-bitI/O Expander
PCAB574 8-bit Level translating /O Expander
PCA9575 16-bit /O Expander
PCAS96T0 &-bit /0 Expander
PCA9671 16-bit /O Expander
PCA9672 &-bit /O Expander
PCA9673 16-bit /O Expander
PCAS674 &-bit /O Expander
PCAS674A 8-bit /O Expander
PCAD9675 16-bit I/O Expander
PCA9698 40-bit /O Expander
PCF&574 8-bit1/0 Expander
PCFa574A 8-bit I/O Expander
PCF8575 16-bit I/O Expander

GPIO Control

Slave Device

Hardware Detected 3.3V 0n 5.0V On
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PCA9500/9501 8-bit I/0 port with interrupt and 2k EEPROM

USB-to-12C Elite - [PCAG500 / PCAG501 System Maintenance and Control Devices] (= | B i
% Eile Device Options Window Help = & =
1/0 Expander

Address == P7 P6 P5 P4 P3 P2 P1 PO
e | ) =
EEPROM Address o1 f2[sfafsfe[r[so]ae[c[p]e[F]

BO

FF | Write IO Read IO [=] Auto Write On

0 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
Word Address 3 |pr Fr FF FF FF FF FF FF FF FF FF FF FF FF FF FF
B 0d 2 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
Write Time (ms) (3 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
10 5 4 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF

'S |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF

Read Byte 6 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
Read All 7 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
Write Byte EFF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF

= 9 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
Write All A |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
Verify B |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
e zFF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
5ol it ||/ l|Ra|FT TF FF FT FT FF FY FF FF FY FY FE FY EF P FE
E |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF

F |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF

Hardware Detected 3.3V 0On 5.0V On 100 kHz

LS

The PCA9500 and PCA9501 are 8-bit I/0 expanders with an on-board 2-kbit EEPROM. The eight quasi
bidirectional data pins can be independently used as inputs or outputs to monitor board level status or
activate indicator devices such as LEDs. The data for each Input or Output is kept in the corresponding Input
or Output register. The system master can read all registers.

Changing 1/0 Expander Data with Checkboxes

The ports, labeled P7 - PO can be set high or low by clicking on them with a mouse. A high logic level is
indicated with a light green color while a low logic level is shown as a dark green color. If a port state is
changed, the data byte box in the write area will be updated to reflect the changes. The new data can be sent
to the PCA950x by pressing the Write Button. If the Auto Write On is enabled (light green), any change in the
state of the Write checkboxes or Write Data Byte will immediately be sent to the PCA950x.

Read 1/0 Button

Upon pressing the Read Button, the program will update the hexadecimal data shown beside the Write I/0
button as well as show the state of the individual I/0s. The I/0 portis low if the port is shown in dark green
and is high if it is light green.

Set Data
All the cells of the memory grid will be filled with the two-digit hexadecimal number found in the Preset edit
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box when the Set Data button is pressed. No information will be sent over the I2C bus.

Word Address

The Word Address (also called subaddress) is a pointer to a register or memory location within the I>C
device. To access this location, the software will send out the device I°C address, followed by this subaddress,
followed by the read or write data. The program displays the subaddress of the active cell of the memory grid
in both hexadecimal and decimal notation.

Read Byte Button

Pressing the 'Read Byte' button initiates a read from the I°C device. The program begins the transmission by
writing the word address, found in the Word Address or Subaddress box, to the device. The word address of
the currently selected cell is shown in the Word Address box on the screen. A Repeated Start is then
generated, followed by a read of the single byte. The result of each byte read is immediately entered in the
appropriate cell in the grid. In addition to pressing the 'Read Byte' button, you may press the <Alt> and <b>
keys simultaneously to achieve the same results.

Read All Button

Pressing the 'Read All' button initiates a read from the 1°C device. The program begins the transmission by
writing the word address 0 to the device. A Repeated Start is then generated, followed by sequential reads of
the entire device. In addition to pressing the 'Read All' button, you may press the <Alt> and <r> keys
simultaneously to achieve the same results.

Write Byte Button

Pressing the 'Write Byte' button initiates a Write to the 1°C device. The program begins the transmission by
writing the slave address and then the word address of the currently active cell in the grid. The selected data
byte is then sent. In addition to pressing the 'Write Byte' button, you may press the <Alt> and <y> keys
simultaneously and achieves the same results.

Write All Button

Pressing the 'Write All' button initiates a Write to the 1°C device. The program begins the transmission by
writing the word address 0 to the device and sequentially writes the entire device.

The software will send one page of data (4 bytes) followed by a STOP condition. An erase/write cycle is
performed before writing another page to the device. In addition to pressing the 'Write All' button, you may
press the <Alt> and <w> keys simultaneously to achieve the same results.

After the completion of the write cycle, USB-to-12C will read the entire device to verify that the contents of the
device match the data that was sent. An error message will be displayed if the data is not verified.
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PCA9534 Eight-Bit Low Power I/O Port with Interrupt
PCA9554(A) Eight-Bit 1/0 Port with Interrupt
PCA9538 Eight-Bit Low Power I/O Port with Interrupt & Reset

The PCA9534, PCA9554(A), and PCA9538 are 16-pin CMOS devices that provide 8 bits of General Purpose
parallel Input/Output (GPI10) expansion for [2C/SMBus applications

The PCA9554 and PCA9554A are similar devices but respond to different i2c addresses. The PCA9534 differs
from the PCA9554(A) in that it does not have pull-up resistors on the outputs. The PCA9538 includes a reset
input.

USE-to-12C Elite - [PCA9534/PCAD538/PCASS54/PCAGS544A /O Expanders) o e S
% Eile Device Options Window Help — || & =
Device Address
0x70 IEI J Auto Write On Wirite All Read All
Register 3 Register 2 Register 1 Register 0
Configuration Polarity Cutput Input
FF o0 FF FF
C7 [Vl Input N7 [C] Mot Inverted 07 [¥] High I7 ‘" High
C6 V] input ME || Mot Inverted 06 Y| High [6 [Vl High
C5 ¥l 1nput M5 [T Mot Inverted 05 [ High [5 [¥]High
C4 [V 1nput M4 | Mot Inverted 04 [V High [4 ¥ High
C3 [¥] input M3 [T Mot Inverted 03 [ High I3 [¥|High
C2 V] input N2 [] Mot Inverted 02 [ High 12 [¥] High
C1 ¥ tnput M1 ] Mot Inverted 01 [¥] High I1 [¥] High
CO [¥] tnput MO [ Mot Inverted 00 [¥] High [0 [¥] High
Write Write Write
Read Read Read Read
Hardware Detected 3.3V On 5.0V On 400 kHz

The four devices have four internal registers. All four registers can be read by the bus master while the Input
register can only be read.

Automatic Write Enable
When Auto Write is enabled (light green), any changes made to Registers 1, 2, or 3 checkboxes will cause the
program to write the new data to the device. The display will read 'Auto Write Off' in when it is disabled and
'Auto Write On' in when enabled.

Checkboxes

The checkboxes indicate the logic level of the various bits in the registers. A checked box is equivalent to logic
‘1’ while an unchecked box is equivalent to logic ‘0’. The logic level can be changed by single clicking on the
checkbox. If Auto Write is enabled (checked), USB-to-12C will write the new value to the device shown in the
Address box. The checkboxes will also be updated when a new value is read by USB-to-12C, or when the value
in the edit boxes is changed.

USB-to-12C Software User’'s Manual Page 31



Edit Boxes

The edit boxes show the current hexadecimal value for each of the 4 registers. Register 0 is a Read-Only
register so the user cannot change this value. If the hexadecimal value is changed by the user, it will be
transmitted by USB-to-12C if the Auto Write is enabled (checked).

The checkboxes will also be updated to reflect any changes to the values of the Edit Box.

Read Buttons

After pressing one of the Read Buttons, USB-to-12C will read the appropriate register and place the
hexadecimal value in the edit box. The checkboxes are updated to reflect the individual bit logic levels.
Pressing the Read All button reads all four registers.

Because the PCA9554(A), PCA9534, and PCA9538 do not automatically increment the register address
between operations, only one register may be read in each transaction. Therefore, after Register 0 has been
read, USB-to-12C will begin a new transaction for each of the other registers. This will continue until all four
registers have been read.

Write Button

Upon pressing one of the Write Buttons, USB-to-12C will write to the appropriate register. Pressing the Write
All button writes to Registers 1, 2, and 3.

Since there is no automatic increment of the register subaddress between writes, only one register may be
written for each Start condition. Therefore, after Register 1 has been written by USB-to-12C, a new
transaction will be sent out so that Register 2 can be written, followed by Register 3.
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PCA9536 Four-Bit 10 Expander
PCA9537 Four-Bit 10 Expander with Interrupt and Reset

The PCA9536 is an 8-pin and the PCA9537 is a 10-pin CMOS device that provide 4 bits of general purpose
parallel Input/Output (GPIO) expansion for I2C and SMBus applications

The PCA9536 and PCA95537 are similar devices; however, the PCA9537 adds an interrupt output and a reset
input. The PCA9536 and PCA9537 have four registers. All four registers can be read by the bus master while
the Input register can only be read.

USB-to-12C Elite - [PCAQ536 / PCAG537 I/O Expanders] =TR=8 X
% File Device Options Window Help - (4
Device Address
s [ Auto Write On Wirite All Read All
Register 3 Reqgister 2 Register 1 Register 0
Configuration Polarity Output Input
FF ili] FF FF
C3 ¥ Input N3 [C] Mot Inverted 03 [V High I3 ¥ High
C2 [¥] Input N2 ] Mot Inverted 02 ¥ High 12 ¥l High
C1 ¥ Input N1 [ Mot Inverted 01 [¥| High I1 ¥ High
CO [¥] nput NO [] not Inverted 00 ¥ High I0 ¥ High
Write Write Write
Read Read Read Read
Hardware Detected 3.3V On 5.0V On 400 kHz

L

Automatic Write Enable

When Auto Write is enabled (checked), any changes made to Registers 1, 2, or 3 checkboxes will cause the
program to write the new data to the device.

Checkboxes

The checkboxes indicate the logic level of the various bits in the registers. A checked box is equivalent to logic
‘1’ while an unchecked box is equivalent to logic ‘0’. The logic level can be changed by single clicking on the
checkbox. If Auto Write is enabled (checked), the new value will immediately be written to the device shown
in the Address box. The checkboxes will also be updated when a new value is read by USB-to-12C, or when
the value in the edit boxes is changed.

Edit Boxes

The edit boxes show the current hexadecimal value for each of the 4 registers. Register 0 is a Read-Only
register so the user cannot change this value. If the hexadecimal value is changed by the user, it will be
transmitted by USB-to-12C if the Auto Write is enabled (checked). The checkboxes will also be updated to
reflect any changes to the values of the Edit Box.
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PCA9535 Sixteen-Bit Low Power I/O Port with Interrupt
PCA9539 Sixteen-Bit Low Power 1/O Port with Interrupt &
Reset

PCA9555 Sixteen-Bit I/O Port with Interrupt

The PCA9555, PCA9535, and PCA9539 are 24-pin CMOS device that provide 16 bits of General Purpose
parallel Input/Output (GPIO) expansion for [2C/SMBus applications and were developed to enhance the NXP
family of I2C I/0 expanders. The improvements include higher drive capability, 5V 1/0 tolerance, lower
supply current, individual I/0 configuration, and smaller packaging. I/0 expanders provide a simple solution
when additional I/0 is needed for ACPI power switches, sensors, pushbuttons, LEDs, fans, etc.

USB-to-I2C Elite - [PCAS535/PCAS555/PCAS539 16-bit IO Expander] e X
% Eile Device Options Window Help - |[&]f =
Device Address Input (Registers 1 and 0)

[0x40 | E| [¥] Auto Write On FF | FF Read Inputs Write All Read All
Registers 7 and 6 Registers 5 and 4 Registers 3 and 2

FF |Configuration FF 0o Polarity 00 FF Qutput  FF
7.7 [¥] Input 6.7 [¥] Input 7 [ |Not Inverted |47 [[] Mot Inverted 3.7 [¥] High 2 7[¥] High
7.6 [¥] Input 6.6 [¥] Input 5.6 []Not Inverted  |4.6 [ Not Inverted 3.6 [¥] High 2 &[] High
7.5 [#] Input 6.5 [¥] Input 5.8 [|Not Inverted (4.5 [[] Mot Inverted 3.5 [¥] High 2 &[] High
7.4 [¥] Input 6.4 [¥] Input 5.4 [|Not Inverted  |4.4 [T Not Inverted 3.4 [¥] High 2 4[] High
7.3 [¥] Input 6.3 [¥] Input 5.3 [CINot Inverted  |4.3 [ Not Inverted 3.3 [¥] High 2.3[¥] High
7.2 [¥] Input 6.2 [¥| Input 5.2 [ INot Inverted |4.2 [|Not Inverted 3.2 [¥| High 2.2V High
7.1 7] Input 6.1 [¥] Input 5.1 [ Not Inverted  |4.1 [C] Not Inverted 3.1[¥] High 2.1[¥ High
7.0 ¥ Input 6.0 [¥ Input 50 [ |Not Inverted 4.0 [ | Not Inverted 3.0[¥|High 2.0[¥|High

Write Write Write Write Write Write
Read Read Read Read Read Read
Write Reg 6/7 Read Reg 6/7 Write Reg 4/5 Read Reg 4/5 Write Reg 2/3 Read Reg 2/3
Hardware Detected 3.3V On 5.0V On 400 kHz

L

These devices consist of pairs of 8-bit registers: Configuration (Input or Output); Input, Output and Polarity
inversion (Active high or Active low operation) registers. The system master can enable the 1/0s as either
inputs or outputs by writing to the I/0 configuration bits. The data for each Input or Output is kept in the
corresponding Input or Output register. The polarity of the read register can be inverted with the Polarity
Inversion Register. All registers can be read by the system master.

Input Registers (subaddress 0x00 and 0x01)

These registers are read-only. They reflect the incoming logic levels of the pins, regardless of whether the pin
is defined as an input or an output by the Configuration Registers. Writes to this register have no effect.

Output Registers (subaddress 0x02 and 0x03)

These registers reflect the outgoing logic levels of the pins defined as outputs by the Configuration Registers.
Bit values in this register have no effect on pins defined as inputs. Reads from this register return the value
that is in the flip-flop controlling the output selection, NOT the actual pin value.
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Polarity Registers (subaddress 0x04 and 0x05)

These registers allow the user to invert the polarity of the Input Port Register data. If a bit in this register is
set (written with ‘1’), the corresponding Input Port data is inverted. If a bit in this register is cleared (written
with a ‘0’), the Input Port data polarity is retained.

Configuration Register (subaddress 0x06 and 0x07)

The Configuration Registers define the directions of the I/0 pins. If a bit in these register is set, the
corresponding port pin is enabled as an input with high impedance output driver. If a bit in these registers is
cleared, the corresponding port pin is enabled as an output. At reset, the [/Os are configured as inputs with a
weak pull-up to Vop.

Automatic Write Enable

When Auto Write On is enabled (green), any changes made to Registers 1 through 7 checkboxes will cause the
program to write the new data to the PCA9555. The display will read 'Auto Write Off' when it is disabled and
'Auto Write On' when enabled.

Checkboxes

The checkboxes indicate the logic level of the various bits in the registers. A checked box is equivalent to logic
‘1’ while an unchecked box is equivalent to logic ‘0’. The logic level can be changed by single clicking on the
checkbox. If Auto Write is enabled (green LED), USB-to-12C will write the new value to the PCA9555
immediately after a change is made.

Edit Boxes

The edit boxes show the current hexadecimal value for each of the 4 registers. Register 0 is a Read-Only
register so the user cannot change this value. If the hexadecimal value is changed by the user, it will be
transmitted by USB-to-12C if the Auto Write is on (checked).

The checkboxes will also be updated to reflect the new value of the Edit Box.

Read Buttons

Upon pressing one of the Read Buttons, USB-to-12C will read the appropriate register and place the
hexadecimal value in the edit box. The checkboxes are updated to reflect the individual bit logic levels.
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PCA9556/PCA9557 Eight-bit I/O Expanders with Reset

The PCA9556 and PCA9557 are CMOS circuit that provides parallel input/output expansion for I2C and
SMBus applications. These devices consist of an 8-bit input port register, 8-bit output port register, and an 12C
interface. It has low current consumption and a high impedance open drain output pin, [/00.

The system master can reset the PCA9556 in the event of a timeout by asserting a LOW on the reset input.
The system master can also invert the PCA9556/PCA9557 inputs by writing to their active HIGH polarity
inversion bits. Finally, the system master can enable the [/Os as either inputs or outputs by writing to the I/0
cronfiguration register.

USB-to-12C Elite - [PCA9556 / PCAS557 [/O Expanders] = B
% Eile Device Options Window Help — ||| =
Device Address
0x30 E| J‘ Auto Write On Write All Read All
Register 3 Register 2 Register 1 Register 0
Configuration Polarity Output Input
FF FO 0o HK
C7 [¥] Input N7 [#] nverted 07 [ Low I7 [H undefined
C6 [¥] Input N6 [¥] inverted 06 [C] Low I6 Undefined
C5 [¥] Input N5 [7] inverted 05 [C] Low IS5  [@ undefined
C4 ¥ Input N4 [7] nverted 04[] Low I4 [® undefined
C3 [¥] Input N3 7] not Inverted 03 ] Low I3 & undefined
C2 [¥] Input N2 [ not Inverted 02 [ Low 12 @ undefined
C1 [¥ Input N1 [ Not Inverted 01 [ Low I1 & undefined
CO [ Input NO [7] not Inverted 00 ] Low I0 @ undefined
Write Write Write
Read Fead Fead Read
Hardware Detected 3.3V On 5.0V On 400 kHz
Auto Write

When the Auto Write On is enabled (green), any changes made by the user to the PCA9556/PCA9557
Registers 1, 2, and 3 will immediately be sent to the PCA9556/PCA9557. If an error is encountered during
this transmission, Auto Write Off will be displayed (red).

Read All Button

Each time the Read All button is pressed, the contents of Registers 0, 1, 2, and 3 are read from the
PCA9556/PCA9557. The register data will be reflected in the state of the checkboxes, with an unchecked box
indicating logic '0" and a checked box indicating logic '1".

Write All Button

When this button is pressed, Registers 1, 2, and 3 are written to the PCA9556/PCA9557. Register 0 is a read-
only register.
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Register 0 (Input Port)

This register is an input-only port. It reflects the incoming logic levels of the pins, regardless of whether the
pin is defined as an input or an output by register 3. Writes to this register have no effect.

Logic '0' is shown as an unchecked checkbox while logic '1' is shown as a checked box.

Register 1 (Output port)

This register is an output-only port. It reflects the outgoing logic levels of the pins defined as outputs by
register 3. Bit values in this register have no effect on pins defined as inputs. In turn, reads from this register
reflect the value that is in the flip-flop controlling the output selection, NOT the actual pin value.

Register 2 (Polarity)

This register enables polarity inversion of pins defined as inputs by register 3. If a bit in this register is set
(written with ‘1"), the corresponding port pin’s polarity is inverted. If a bit in this register is cleared (written
with a ‘0’), the corresponding port pin’s original polarity is retained.

Register 3 (Configuration)

This register is an input-only port. It reflects the incoming logic levels of the pins, regardless of whether the
pin is defined as an input or an output by register 3. Writes to this register have no effect. This register
configures the directions of the I/0 pins. If a bit in this register is set (written with ‘1), the corresponding
port pin is enabled as an input with high impedance output driver. If a bit in this register is cleared (written
with ‘0’), the corresponding port pin is enabled as an output.
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PCA9698 Forty-bit I/O Expander

The PCA9698 provides 40-bit parallel input/output (I/0) port expansion for [2C-bus applications organized
in five banks of eight [/Os. At 5 V supply voltage, the outputs are capable of sourcing 10 mA and sinking 25
mA with a total package load of 1 A to allow direct driving of 40 LEDs. Any of the 40 I/0 ports can be
configured as an input or output.

The device is fully configurable: output ports can be programmed to be totem-pole or open-drain and logic
states can change at either the Acknowledge (bank change) or the Stop Command (global change), each input
port can be masked to prevent it from generating interrupts when its state changes, I/0 data logic state can
be inverted when read by the system master.

An open-drain interrupt output pin (INT) allows monitoring of the input pins and is asserted each time a
change occurs in one or several input ports (unless masked). The Output Enable pin (OE) 3-states any I/0
selected as output and can be used as an input signal to blink or dim LEDs (PWM with frequency > 80 Hz and

change duty cycle).
i N
USB-to-12C Elite - [PCAD505 / PCAS506 / PCA9698 40-bit IO Expander] _ l == ﬁ
H Eile Device Options Window Help =& =
||§"1 Device cgnﬁguratignkﬂ; Bank 0 |;ﬂ'; Bank 1 kﬁ Bank 2 |;ﬁ'; Bank 3 |(§;. Bank 4 %Devic& D |‘ Alert Response | 4 b
QUTCONF
OUT1 BAMNK1 : totem-pole |Z| OUTO01 I00_0 and I00_1 are totem-pole |Z| OUTCOMNF=0xFF
OUT2 BANK2 : totem-pole |»| 0UT023 100_2 and 100_3 are totem-pole = Write I2C Address
OUT3 BAMNKS : totem-pole |Z| OUTD45 I00_4 and I00_5S are totem-pole |Z| Read 0x40 IZ|
a3
OUT4 BANK4 : totem-pole Izl QUTO67 I00_6 and I00_7 are totem-pole Izl _
Auto Write On
ALLBNK
BSEL 1 [~
B4 0: all IOs configured as output in Bank 4 are programmed with actual value | Wi
= ALLBNK=0x80 g Al
B3 0: all 10s configured as output in Bank 3 are programmed with actual value 1=
B2 0: all 10=s configured as output in Bank 2 are programmed with actual value |v| \rite Read All
Bl 0: all I0s configured as output in Bank 1 are programmed with actual value I~ Read
BO 0: all 10s configured as output in Bank 0 are programmed with actual value i
MODE =
SMBA No response to Alert Response ™| MODE=0x02
IOAC Does not respond to 'All Call’ -
] Write
QCH Change on ACK i
QOEPQOL QE pin is active LOW hd Read
Hardware Detected  33V0n  50V0n 400 kHz

-—————

Due to the number of registers in the PCA9698, the application interface is split into multiple pages.

Device Configuration
The first page of controls includes the OUTCONF, ALLBNK, and MODE registers.

Read All Button

The Read All button will read all the registers in the PCA9698, not only the registers shown on the active
page.

Write All Button
The Write All button will write all the registers in the PCA9698, not only the registers shown on the active

page.

Bank Registers
Each eight-bit 10 within the PCA9698 has a separate page with the five registers used to control it.
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USB-to-12C Elite - [PCAJ505 / PCAGS06 / PCAIEIS 40-bit 10 hpand_‘lglﬂu
Ef File Device Options Window Help . [-[=]x]
| &) Device Configuration |@ Bank 0 |@ Bank 1 |& Bank 2 |@ Bank 3 |& Bank 4 |&Device D | @ Alert Response | 4 b
Input Port O Qutput Port 0 Polarity Port O Configuration 0 Mask Interrupts 0
oo 0o 0o FF FF
12C Address
[ 1P7 O op7 [Ce1z 10C7 MSK7
0x40 [
Cre [l ope [ P16 10C6 MSKG
Auto Write On
O ®s [l ops [ P15 10C5 MSKS =
[C] P4 OP4 ] pH4 10C4 M5K4
Write All
[C]1P3 0P3 P13 10C3 M5K3
B2 op2 e 102 MSK2 gead Al
[Pl oP1 Oen 10C1 MSK1
[P0 OPOD [l p10 10C0 MSKD
Checked=high Checked=high Checked=inverted Checked=input Checked=masked
Uncheck=low Uncheck=low Uncheck=normal Uncheck=output Uncheck=unmasked
Write Write Write Write
Read Read Read Read Read
Hardware Detected 3.3V0n 5.0¥ On 400 kHz
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PCF8574/PCF8574A Eight-bit 1/O Expander

The PCF8574 provides general-purpose remote 1/0 expansion for most microcontroller families via the I2C
bus. The device consists of an 8-bit quasi bi-directional port and an I2C interface. The PCF8574 has low
current consumption and includes latched outputs with high current drive capability for directly driving
LEDs. It also possesses an open-drain interrupt output that can be connected to the interrupt logic of the
microcontroller. By sending an interrupt signal on this line, the remote 1/0 can inform the microcontroller if
there is incoming data on its ports without having to communicate via the I?C bus. This means that the
PCF8574 can remain a simple slave device.

’lr"he PCF8574 and PCF8574A differ only in their slave addresses.

USB-to-12C Elite - [PCF8574 8-bit 1/0 Expander] =non X
% File Device Options Window Help = (& =
Device Address
0x40 B [¥] Auto Write On
Write to Read Input
Output
FF 7
] p7 [ P7
¥l pe [ Pa
¥ p5 ] P5
V] P4 [CIr4
[¥] p3 O] P3
7] p2 [[] P2
Jp1 Cr1
V] PO | PO
Write Read
Hardware Detected 3.3V On 5.0V On 400 kHz
Checkboxes

The checkboxes, labeled PO - P7, in the write areas of the PCF8574(A) screen can be checked/unchecked by
clicking on them with a mouse. If a checkbox state is changed, the data byte box in the write area will be
updated to reflect the changes. The new data can be sent to the PCF8574(A) by pressing the Write Button. If
the Auto Write On is checked, any change in the state of the Write checkboxes or Write Data Byte will
immediately be sent to the PCF8574(A).

The checkboxes found in the Read PCF8574(A) panels are read only and can only be changed by the software
by clicking the Read buttons. If a checkbox is checked, this indicates logic '1', while an unchecked box
indicates logic '0'".

Read Button
Upon pressing the Read Button, the program will update the hexadecimal data shown beside the button as
well as show the state of the individual I/0s. The I/0 is low if the checkbox is unchecked and high if it is
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checked.
Read Data

The Read boxes on the PCF8574(A) screens are read-only. The user cannot change the contents of any edit
boxes or checkboxes in this area. The information is updated only by pressing the Read Button.

Data read from the PCF8574(A) will be shown in the box beside the Read Button. The checkboxes are then
changed to show the value of each individual I/0O of the device. If the checkbox is checked, then the I/0 pin is
high while an unchecked box means that the [/0 pin is low.

It is important to remember that before any I/0s in the PCF8574(A) can be used as inputs, they must be set
high first. The program does not do this for you.

Data Byte

Any two-digit hexadecimal number may be entered in this data box. When it is changed, the checkboxes
labeled PO - P7 will also change showing the current value of the data which will be written to the
PCF8574(A).

Write Button

Pressing the Write Button will send an I°C message to the PCF8574(A) consisting of: a Start condition, the I*C
address, the data byte, followed by the Stop condition. Note that if Automatic Write Enable is checked, any
changes to the data box will be sent any time a change is made.

Automatic Write Enable

When Auto Write On is enabled (light green), any changes made to the P0-P7 checkboxes will cause the
program to write the new data to the PCF8574(A). The display will read 'Auto Write Off when it is disabled
and 'Auto Write On' when enabled.

Auto Read Back

When this function is enabled (light green), the software will immediately read the PCF8574 after it has
performed a write. The result of the read will be displayed in the Read groupbox.
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PCF8575 16-bit I/O Expander

The PCF8575 is a CMOS circuit which provides general purpose remote 1/0 expansion for most
microcontroller families via the two-line bi-directional bus (I12C-bus).

The device consists of a 16-bit quasi bi-directional port and an I?C-bus interface. The PCF8575 has a low
current consumption and includes latched outputs with high current drive capability for directly driving
LEDs. It also possesses an interrupt line (INT) which can be connected to the interrupt logic of a
microcontroller. By sending an interrupt signal on this line, the remote 1/0 can inform the microcontroller if
there is incoming data on its ports without having to communicate via the I*C bus. This means that the
PCF8575 is an I°C-bus slave transmitter/receiver.

Every data transmission from the PCF8575 must consist of an even number of bytes; the first byte will be
referred to as P07 to P00 and the second byte as P17 to P10. The third will be referred to as P07 to P00 and
So on.

( U5E-to-12C Elite - [PCFB575 16-bit I/0 Expander] =En X )
ﬁ Eile Device Options Window Help - || 5| =
Device Address
0x40 IEI [¥] Aute write On
& Write to Read Input
Output
| A G w»
Mlp15 [¥]p7 Clpis [Clez
| @lr14 [@pe Flr14 [Flre
WP13 [WIP5 Clp13 [Ces
Mir12 [FIp4 Clr12 [Cpra
| P11 [#p3 [[p11 [Ep2
i “p1io ¥ p2 [Cri0 [z
: Mpo [¥]p1 Clee [Epe1
| Wirs [V]Po Clee [Ero
| Write Ports 0 and 1 Read Ports 0and 1
: Write Port O Read Part 0
|
1 Hardware Detected 3.3W0On  5.0V0On 100 kHz

Read Checkboxes

There are sixteen checkboxes in the Read box. The contents of the PCF8575 are read by pressing the Read
button. A checked item indicates logic '1' while an unchecked item means logic '0'. The user cannot change
the checkboxes since these are read-only.

Write Checkboxes

Clicking on the checkboxes will invert the current state of the bit. Logic '0' is shown as an unchecked box
while logic '1" is shown as a checked box. If Auto Write is on, then any changes made to these checkboxes will
immediately be sent to the PCF8575.
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Read Button

When this button is pressed, the two eight-bit registers are read via the I>C bus.
Data from Port 0 is read first, followed by Port 1. The data bytes are displayed in the area beside the Read
button and the checkboxes are updated.

Write Button

When the Write button is pressed, the contents of the High and Low data boxes are sent to the PCF8575 via
the I?C bus.

Read Data Boxes
These two boxes show the port state of the PCF8575 in hexadecimal format.
These boxes cannot be directly modified by the user but must be changed by pressing the read button.

Write Data Boxes

The user can change the contents of the register by entering a two-digit hexadecimal number into the upper
and/or lower edit boxes. If the Auto Write is enabled, both data registers are sent, even if only one is
changed.

Auto Write

When the Auto Write is enabled, any changes made by the user to the PCF8575 checkboxes on the screen will
immediately be sent to the PCF8575 via the IC bus.
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LED Blinkers and Dimmers

The USB-to-12C software supports 18 common LED blinkers and dimmers.

File IDeuice Options  Window Help

EEPROM
I/0 Expanders

LED Blinkers and Dimmers

Master Selector (2-to-1 dermux)
Multiplexers,Switches

Mon-volatile Registers
RAM / FRAM

Real Time Clocks
Thermal Management

Universal Modes
GPIO Control

Slave Device

PCAS530 2-bit LED Dimmer with 8-bit PWHM

PCA9531 8-bit LED Dimmer with 8-bit PWM

PCAS532 &-bit LED Dimmer with 8-bit PWM

PCAOG533 4-bit LED Dimmer with &-bit PWHM

PCAS550 2-bit LED Blinker with 8-bit PWM

PCAS551 8-bit LED Blinker with 8-bit PWM

PCA9552 16-bit LED Blinker with 8-bit PWM

PCAS553 4-bit LED Blinker with 8-bit PWM

PCA9622 16-bit 100ma 40V LED Driver with 8-bit PWM
PCAS624 8-bit 100maA 40V LED Driver with &-bit PWM
PCAS626 24-bit 100mA 40V LED Driver with 8-bit PWM
PCA9E32 Low-power 4-bit LED Driver with 8-bit PWM
PCA9633 4-bit LED Driver with 8-bit PWHM

PCA9634 8-bit LED Driver with 8-bit PWHM

PCAS635 16-bit LED Driver with B-bit PWM

PCAS685 16-channel LED Driver with 12-bit PWM
PCA9955 16-channel Constant Current LED Driver
SAA1064 LED Driver
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PCA9530 Two-bit 12C LED Dimmer

The PCA9530 LED Blinker blinks LEDs in I2C applications where it is necessary to limit bus traffic or free up
the I12C Master’s (MCU, MPU, DSP, chipset, etc.) timer. The uniqueness of this device is the internal oscillator
with two programmable blink rates. To blink LEDs using normal I/0 Expanders like the PCF8574 or
PCA9554, the bus master must send repeated commands to turn the LED on and off. This greatly increases
the amount of traffic on the I2C bus and uses up one of the master’s timers. The PCA9530 LED Blinker instead
requires only the initial set up command to program BLINK RATE 1 and BLINK RATE 2 (i.e., the frequency
and duty cycle) for each individual output.

USB-to-12C Elite - [PCAY530 2-bit LED Dimmer] [ o e
H Eile Device Options Window Help (L
LED Mode Select
LED 1 LED O
PWM 1 PWM O Registers
Period  Duty Cyde Period  Duty Cyde 12C Address

Input Register OxC2 |E|

Frequency

Prescaler 0

PWM Register 0

Write All

Frequency

Prescaler 1 Read Input

PWM Register 1 Read All

LED Selector 0-1
0.007 sec 50.00%: 0.007 sec 50.00 %
152.00 Hz 152,00 Hz

Hardware Detected 3.3V On 5.0V On 400 kHz

L

Device Address
The device 12C address can be selected by choosing one of the hexadecimal selections from the drop-down
list. The default address at start-up is 0xCO.

Auto Write On/Off Button

When Auto Write is disabled (LED off), the software can be modified without transmitting data to through the
parallel port. When the Auto Write LED is on, any changes made to the software is immediately transmitted
to the PCA9530.

LED Mode Selector

Each LED can be set in one of four modes: ON, OFF, PWMO, and PWM1. The mode is selected by moving the
switches to the appropriate mode for the LED. All LEDs set to PWMzx will blink at the same frequency, duty
cycle, and phase.
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PWM Period Slidebar

The period of the PCA9530 can be changed by moving the PWMO or PWM1 slidebars. The period (in seconds)
and frequency (in Hertz) is displayed below the slidebar. The actual value of the PCA9530 register is
displayed in the Registers groupbox.

PWM Duty Cycle

The duty cycle for PWMO0 and PWM1 can be changed by moving the PWMO or PWM1 slidebars. The duty
cycle is displayed (in percent) below the slidebar. The actual value of the PCA9530 register is displayed in the
Registers groupbox.

Write All Button
Pressing the Write All button causes Registers 1 through 6 to be programmed.

Read Input Register
When the Read Input register button is pressed, the Input register is read, and the data is presented in the
Registers groupbox.

Read All Button

Pressing the Read All button will read all the device registers from the PCA9530 using the auto-increment
feature. Since the PCA9530 devices don’t allow auto-increment starting from Register 0, the reads start with
the register with the highest address which causes the auto-increment pointer to roll-over to Register 0
(Input Register). The reads continue until the all the registers have been read.

The data will be displayed in the Registers groupbox and the controls (sliders, switches) will be updated.
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PCA9531 Eight-bit 12C LED Dimmer

The PCA9531 is an 8-bit [2C-bus and SMBus 1/0 expander optimized for dimming LEDs in 256 discrete steps
for Red/Green/Blue (RGB) color mixing and back light applications.

USB-to-12C Elite - [PCA9531 8-bit LED Driver / Blinker] o e S
H File Device Options Window Help — || =
LED Mode Select
LED 7 LED &6 LED 5 LED 4 LED 3 LED 2 LED 1 LED 0O
OFF PWM1 PWM1 PWM1 OM PWMOD PWMD OM
PWM 1 PWM O Registers (hex)
Period  Duty Cyde Period  Duty Cyde
Input Register I2C Address
0xC0
Frequency % |E|
Prescaler 0

Auto Write Off
PWM Register 0

Frequency .
Prescaler 1 Write All
PWM Register 1 Read Input
I LED Selector 0-3 Read All
0.007 sec 50.00% 0.007 sec LED Selector 4-7
152,000 Hz 152,000 Hz
Hardware Detected 3.3V On 5.0V On 400 kHz

Device Address
The device 12C address can be selected by choosing one of the hexadecimal selections from the drop-down
list. The default address at start-up is 0xCO.

Auto Write On/Off Button

When Auto Write is disabled (LED off), the software can be modified without transmitting data to through the
parallel port. When the Auto Write LED is on, any changes made to the software is immediately transmitted
to the PCA9531.

LED Mode Selector

Each LED can be set in one of four modes: ON, OFF, PWMO0, and PWM1. The mode is selected by moving the
switches to the appropriate mode for the LED. All LEDs set to PWMx will blink at the same frequency, duty
cycle, and phase.

PWM Period Slidebar

The period of the PCA9531 can be changed by moving the PWMO or PWM1 slidebars. The period (in seconds)
and frequency (in Hertz) is displayed below the slidebar. The actual value of the PCA9531 register is
displayed in the Registers groupbox.
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PWM Duty Cycle

The duty cycle for PWMO0 and PWM1 can be changed by moving the PWMO or PWM1 slidebars. The duty
cycle is displayed (in percent) below the slidebar. The actual value of the PCA9531 register is displayed in the
Registers groupbox.

Write All Button
Pressing the Write All button causes Registers 1 through 6 to be programmed.

Read Input Register
When the Read Input register button is pressed, the Input register is read, and the data is presented in the
Registers groupbox.

Read All Button

Pressing the Read All button will read all the device registers from the PCA9531 using the auto-increment
feature. Since the PCA955x devices don’t allow auto-increment starting from Register 0, the reads start with
the register with the highest address which causes the auto-increment pointer to roll-over to Register 0
(Input Register). The reads continue until the all the registers have been read.

The data will be displayed in the Registers groupbox and the controls (sliders, switches) will be updated.
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PCA9532 Sixteen-bit 12C LED Dimmer

The PCA9532 is a 16-bit [2C-bus and SMBus 1/0 expander optimized for dimming LEDs in 256 discrete steps
for

Red/Green/Blue (RGB) color mixing and back light applications. The PCA9532 contains an internal oscillator
with two user programmable blink rates and duty cycles coupled to the output PWM. The LED brightness is
controlled by setting the blink rate high enough (> 100 Hz) that the blinking cannot be seen and then using
the duty cycle to vary the amount of time the LED is on and thus the average current through the LED.

The initial set-up sequence programs the two blink rates/duty cycles for each individual PWM. From then on,
only one command from the bus master is required to turn individual LEDs ON, OFF, BLINK RATE 1 or BLINK
RATE 2. Based on the programmed frequency and duty cycle, BLINK RATE 1 and BLINK RATE 2 will cause the
LEDs to appear at a different brightness or blink at periods up to 1.69 seconds. The open drain outputs
directly drive the LEDs with maximum output sink current of 25 mA per bit and 200 mA per package (100 mA
per octal).

i N

USB-to-12C Elite - [PCA9532 16-bit LED Driver / Blinker] o S

HE”E Device Options  Window Help — ||

LED Mode Select
LED15 (LED14 |LED13 (LED12 |LED11 |LED1D (LEDS |LED 8 IED7 |lED6 |LEDS |[LED4 |[IED3 (LEDZ |LED 1 | LED O

PWMI | FWMO PWMO | OFF PWWM1 PWMO | PWMO | PWMO
PWWM 1 PWM 0 Registers (hex)
Period  Duty Cycle Period  Duty Cycle Input Register

oxco  [v]

Input Register

Frequency Prescaler 0 .
Auto Write Off

PWM Register 0

Frequency Prescaler 1

=
=
=
=

Write All
PWM Register 1
LED Selector 0-3 Read Input
LED Selector4-7
0.007sec | 50.00% 0.013sec | 50.00 % LED Selector 8-11 Fead Al
152,000 Hz 76,000 Hz LED Selector 4-7
Hardware Detected 3.3V 0On 5.0V On 400 kHz

Device Address

The device 12C address can be selected by choosing one of the hexadecimal selections from the drop-down
list. The default address at start-up is 0xCO.

Auto Write On/Off Button

When Auto Write is disabled (LED off), the software can be modified without transmitting data to through the

parallel port. When the Auto Write LED is on, any changes made to the software is immediately transmitted
to the PCA9532.
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LED Mode Selector

Each LED can be set in one of four modes: ON, OFF, PWMO, and PWM1. The mode is selected by moving the
switches to the appropriate mode for the LED. All LEDs set to PWMzx will blink at the same frequency, duty
cycle, and phase.

PWM Period Slidebar

The period of the PCA9532 can be changed by moving the PWMO or PWM1 slidebars. The period (in seconds)
and frequency (in Hertz) is displayed below the slidebar. The actual value of the PCA9532 register is
displayed in the Registers groupbox.

PWM Duty Cycle

The duty cycle for PWMO and PWM1 can be changed by moving the PWMO or PWM1 slidebars. The duty
cycle is displayed (in percent) below the slidebar. The actual value of the PCA9532 register is displayed in the
Registers groupbox.

Write All Button
Pressing the Write All button causes Registers 1 through 6 to be programmed.

Read Input Register
When the Read Input register button is pressed, the Input register is read, and the data is presented in the
Registers groupbox.

Read All Button

Pressing the Read All button will read all the device registers from the PCA9532 using the auto-increment
feature. Since these devices don’t allow auto-increment starting from Register 0, the reads start with the
register with the highest address which causes the auto-increment pointer to roll-over to Register 0 (Input
Register). The reads continue until the all the registers have been read.

The data will be displayed in the Registers groupbox and the controls (sliders, switches) will be updated.
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PCA9533 Four-bit 12C LED Dimmer

The PCA9533 is a 4-bit 12C and SMBus 1/0 expander optimized for dimming LEDs in 256 discrete steps for
Red/Green/Blue (RGB) color mixing and back light applications. The PCA9533 contains an internal oscillator
with two user programmable blink rates and duty cycles coupled to the output PWM. The LED brightness is
controlled by setting the blink rate high enough (> 100 Hz) that the blinking cannot be seen and then using
the duty cycle to vary the amount of time the LED is on and thus the average current through the LED.

The initial setup sequence programs the two blink rates/duty cycles for each individual PWM. From then on,
only one command from the bus master is required to turn individual LEDs ON, OFF, BLINK RATE 1 or BLINK
RATE 2. Based on the programmed frequency and duty cycle, BLINK RATE 1 and BLINK RATE 2 will cause the
LEDs to appear at a different brightness or blink at periods up to 1.69 second. The open drain outputs directly
drive the LEDs with maximum output sink current of 25 mA per bit and 100 mA per package.

USB-to-12C Elite - [PCAS533 4-bit LED Dimmer] =Tra X
E File Device Options Window Help = ||| =
LED Mode Select
LED 3 LED 2 LED 1 LED O
PWM1 Rate PWM1 Rate PWM1 Rate PWM1 Rate
PWMO Rate PWMO Rate PWMO Rate PWMO Rate
On On On On
Off off Off Off
PWM 1 PWM O Registers (hex)
Period Duty Cyde Period Duty Cyde
Input Reqister OxCd |E|
Frequency
Prescaler 0 7| Auto Write On

PWM Register O

Write All
Frequency
Prescaler 1
Read Input
PWM Register 1
Fead All
—_— | LED Selector 0-3 -
0.007 sec 50.00% 0.007 sec
152.00 Hz 152,000 Hz
Transmission successful Hardware Detected 3.3V On 5.0V On 400 kHz

Device Address

The device 12C address can be selected by choosing one of the hexadecimal selections from the drop-down
list. The default address at start-up is 0xCO.

Auto Write On/Off Button

When Auto Write is disabled (LED off), the software can be modified without transmitting data to through the
parallel port. When the Auto Write LED is on, any changes made to the software is immediately transmitted
to the PCA9533.
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LED Mode Selector

Each LED can be set in one of four modes: ON, OFF, PWMO, and PWM1. The mode is selected by moving the
switches to the appropriate mode for the LED. All LEDs set to PWMzx will blink at the same frequency, duty
cycle, and phase.

PWM Period Slidebar

The period of the PCA9533 can be changed by moving the PWMO or PWM1 slidebars. The period (in seconds)
and frequency (in Hertz) is displayed below the slidebar. The actual value of the PCA9533 register is
displayed in the Registers groupbox.

PWM Duty Cycle

The duty cycle for PWMO and PWM1 can be changed by moving the PWMO or PWM1 slidebars. The duty
cycle is displayed (in percent) below the slidebar. The actual value of the PCA9533 register is displayed in the
Registers groupbox.

Write All Button
Pressing the Write All button causes Registers 1 through 6 to be programmed.

Read Input Register
When the Read Input register button is pressed, the Input register is read, and the data is presented in the
Registers groupbox.

Read All Button

Pressing the Read All button will read all the device registers from the PCA9533 using the auto-increment
feature. Since the PCA955x devices don’t allow auto-increment starting from Register 0, the reads start with
the register with the highest address which causes the auto-increment pointer to roll-over to Register 0
(Input Register). The reads continue until the all the registers have been read.

The data will be displayed in the Registers groupbox and the controls (sliders, switches) will be updated.
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PCA9550 Two-bit 12C LED Blinker

The PCA9550 LED Blinker blinks LEDs in [2C-bus and SMBus applications where it is necessary to limit bus
traffic or free up the I12C Master’s (MCU, MPU, DSP, chipset, etc.) timer. The uniqueness of this device is the
internal oscillator with two programmable blink rates. To blink LEDs using normal [/0 Expanders like the
PCF8574 or PCA9554, the bus master must send repeated commands to turn the LED on and off. This greatly
increases the amount of traffic on the [2C-bus and uses up one of the master’s timers. The PCA9550 LED
Blinker instead requires only the initial set up command to program BLINK RATE 1 and BLINK RATE 2 (i.e,,
the frequency and duty cycle). From then on, only one command from the bus master is required to turn each
individual open drain output ON, OFF, or to cycle at BLINK RATE 1 or BLINK RATE 2. Maximum output sink
current is 25 mA per bit and 50 mA per package.

il N
USB-to-12C Elite - [PCA9550 2-bit LED Driver / Blinker] SO0 X
H Eile Device Options Window Help = | & =
LED Mode Select
LED 1 LED O
PWM1 OFF
PWM 1 PWM 0 Registers
Period  Duty Cyde Period  Duty Cyde 12 Address
Input Register - 0xC2 E
Frequency _
Prescaler 0 @ Auto Write Off
PWM Register 0 ﬁ
Write All
Frequency ﬁ
Prescaler 1
| Read Input
PWM Register 1 ﬁ
Read All
LED Selector 0-1 ﬁ
1.575 sec 50.,00% 4,525 sec
0.63492 Hz 0.221Hz
Hardware Detected 3.3V On 5.0V On 400 kHz
LS

Device Address
The device 12C address can be selected by choosing one of the hexadecimal selections from the drop-down
list. The default address at start-up is 0xCO.

Auto Write On/Off Button

When Auto Write is disabled (LED off), the software can be modified without transmitting data to through the
parallel port. When the Auto Write LED is on, any changes made to the software is immediately transmitted
to the PCA9550.
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LED Mode Selector

Each LED can be set in one of four modes: ON, OFF, PWMO, and PWM1. The mode is selected by moving the
switches to the appropriate mode for the LED. All LEDs set to PWMx will blink at the same frequency, duty
cycle, and phase.

PWM Period Slidebar

The period of the PCA9550 can be changed by moving the PWMO or PWM1 slidebars. The period (in seconds)
and frequency (in Hertz) is displayed below the slidebar. The actual value of the PCA9550 register is
displayed in the Registers groupbox.

PWM Duty Cycle

The duty cycle for PWMO and PWM1 can be changed by moving the PWMO or PWM1 slidebars. The duty
cycle is displayed (in percent) below the slidebar. The actual value of the PCA9550 register is displayed in the
Registers groupbox.

Write All Button
Pressing the Write All button causes Registers 1 through 5 to be programmed.

Read Input Register
When the Read Input register button is pressed, the Input register is read, and the data is presented in the
Registers groupbox.

Read All Button

Pressing the Read All button will read all the device registers from the PCA9550 using the auto-increment
feature. Since the PCA955x devices don’t allow auto-increment starting from Register 0, the reads start with
the register with the highest address which causes the auto-increment pointer to roll-over to Register 0
(Input Register). The reads continue until the all the registers have been read.

The data will be displayed in the Registers groupbox and the controls (sliders, switches) will be updated.
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PCA9551 Eight-bit 12C LED Blinker

The PCA9551 LED blinker blinks LEDs in 12C-bus and SMBus applications where it is necessary to limit bus
traffic or free up the I2C-bus master's (MCU, MPU, DSP, chip set, etc.) timer. The uniqueness of this device is
the internal oscillator with two programmable blink rates. To blink LEDs using normal I/0 expanders like the
PCF8574 or PCA9554, the bus master must send repeated commands to turn the LED on and off. This greatly
increases the amount of traffic on the [2C-bus and uses up one of the master's timers. The PCA9551 LED
blinker instead requires only the initial set-up command to program BLINK RATE 1 and BLINK RATE 2 (i.e.,
the frequency and duty cycle) for each individual output. From then on, only one command from the bus
master is required to turn each individual open-drain output on, off, or to cycle at BLINK RATE 1 or BLINK
RATE 2. Maximum output sink current is 25 mA per bit and 100 mA per package. Any bits not used for
controlling the LEDs can be used for General Purpose parallel Input/Output (GPIO) expansion.

© N

USB-to-12C Elite - [PCA9551 8-bit LED Driver / Blinker] S S

H File Device Options Window Help = || & %
LED Mode Select
LED 7 LED 6 LED 5 LED 4 LED 3 LED 2 LED 1 LED O

OFF OFF OFF OFF OFF OFF OFF

OFF
PWM 1 PWM O Registers (hex)
Period Duty Cycle Period Duty Cycle I12C Address
Input Register %0
Frequency
Prescaler 0

|| Auto Write On
PWM Register 0

Frequency

Prescaler 1 Wirite Al

PWM Register 1 Read Input

LED Selector 0-3 Read All
6.400 =ec | 50.00% 6.400 =ec (50.00 % LED Selector 4-7
0.156 Hz 0.156 Hz

Hardware Detected 3.3V On 5.0V On 400 kHz

Device Address

The device 12C address can be selected by choosing one of the hexadecimal selections from the drop-down
list. The default address at start-up is 0xCO.

Auto Write On/Off Button

When Auto Write is disabled (LED off), the software can be modified without transmitting data to through the
parallel port. When the Auto Write LED is on, any changes made to the software is immediately transmitted
to the PCA9551.
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LED Mode Selector

Each LED can be set in one of four modes: ON, OFF, PWMO, and PWM1. The mode is selected by moving the
switches to the appropriate mode for the LED. All LEDs set to PWMx will blink at the same frequency, duty
cycle, and phase.

PWM Period Slidebar

The period of the PCA9551 can be changed by moving the PWMO or PWM1 slidebars. The period (in seconds)
and frequency (in Hertz) is displayed below the slidebar. The actual value of the PCA9551 register is
displayed in the Registers groupbox.

PWM Duty Cycle

The duty cycle for PWMO and PWM1 can be changed by moving the PWMO or PWM1 slidebars. The duty
cycle is displayed (in percent) below the slidebar. The actual value of the PCA9551 register is displayed in the
Registers groupbox.

Write All Button
Pressing the Write All button causes Registers 1 through 6 to be programmed.

Read Input Register
When the Read Input register button is pressed, the Input register is read, and the data is presented in the
Registers groupbox.

Read All Button

Pressing the Read All button will read all the device registers from the PCA9551 using the auto-increment
feature. Since the PCA955x devices don’t allow auto-increment starting from Register 0, the reads start with
the register with the highest address which causes the auto-increment pointer to roll-over to Register 0
(Input Register). The reads continue until the all the registers have been read.

The data will be displayed in the Registers groupbox and the controls (sliders, switches) will be updated.
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PCA9552 Sixteen-bit 12C LED Blinker

The PCA9552 LED blinker blinks LEDs in 12C-bus and SMBus applications where it is necessary to limit bus
traffic or free up the I2C-bus master's (MCU, MPU, DSP, chip set, etc.) timer. The uniqueness of this device is
the internal oscillator with two programmable blink rates. To blink LEDs using normal I/0 expanders like the
PCF8574 or PCA9554, the bus master must send repeated commands to turn the LED on and off. This greatly
increases the amount of traffic on the [2C-bus and uses up one of the master's timers. The PCA9552 LED
blinker instead requires only the initial setup command to program BLINK RATE 1 and BLINK RATE 2 (that
is, the frequency and duty cycle) for each individual output. From then on, only one command from the bus
master is required to turn each individual open-drain output on, off, or to cycle at BLINK RATE 1 or BLINK
RATE 2. Maximum output sink current is 25 mA per bit and 200 mA per package.

Any bits not used for controlling the LEDs can be used for General Purpose Parallel Input/Output (GP10)
expansion.

USB-to-12C Elite - [PCAG552 16-bit LED Driver / Blinker] =OPO X

H File Device Options Window Help — | &
LED Mode Select
LED15 |LED14 [LED13 |LED12 |LED11 |LED10 |LED 9 |LED 8 |LED 7 |LED 6 |[LED S5 |LED 4 |LED 3 |LED 2 |LED 1 |[LED O

OFF  |PWMO [PWMO |PWM1 PWMOD  [PWMO [PWMO PWM1 [PWM1 | OFF OFF OFF OFF
PWM 1 PWM 0 Registers (hex)
Period  Duty Cycle Period  Dufty Cycle Input Register

12C Address

oxco [~

Auto Write On

Input Register

Frequency Prescaler 0

PWM Register 0

Frequency Prescaler 1 Write All
PWM Register 1
REead Input
LED Selector 0-3
LED Selector 4-7 Read All
LED Selector 8-11
4.650 sec | 50.00% 2.075 sec | 50.00 %
0.215 Hz 0.482 Hz LED Selector 12-15
Hardware Detected 3.3V 0On 5.0V On 400 kHz
L -

Device Address

The device 12C address can be selected by choosing one of the hexadecimal selections from the drop-down
list. The default address at start-up is 0xCO.

Auto Write On/Off Button

When Auto Write is disabled (LED off), the software can be modified without transmitting data to through the
parallel port. When the Auto Write LED is on, any changes made to the software is immediately transmitted
to the PCA9552.

LED Mode Selector

Each LED can be set in one of four modes: ON, OFF, PWMO, and PWM1. The mode is selected by moving the
switches to the appropriate mode for the LED. All LEDs set to PWMzx will blink at the same frequency, duty
cycle, and phase.
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PWM Period Slidebar

The period of the PCA9552 can be changed by moving the PWMO or PWM1 slidebars. The period (in seconds)
and frequency (in Hertz) is displayed below the slidebar. The actual value of the PCA9552 register is
displayed in the Registers groupbox.

PWM Duty Cycle

The duty cycle for PWMO and PWM1 can be changed by moving the PWMO or PWM1 slidebars. The duty
cycle is displayed (in percent) below the slidebar. The actual value of the PCA9552 register is displayed in the
Registers groupbox.

Write All Button
Pressing the Write All button causes Registers 1 through 6 to be programmed.

Read Input Register
When the Read Input register button is pressed, the Input register is read, and the data is presented in the
Registers groupbox.

Read All Button

Pressing the Read All button will read all the device registers from the PCA9552 using the auto-increment
feature. Since the PCA955x devices don’t allow auto-increment starting from Register 0, the reads start with
the register with the highest address which causes the auto-increment pointer to roll-over to Register 0
(Input Register). The reads continue until the all the registers have been read.

The data will be displayed in the Registers groupbox and the controls (sliders, switches) will be updated.
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PCA9553 Four-bit 12C LED Blinker

The PCA9553 LED Blinker blinks LEDs in [2C-bus and SMBus applications where it is necessary to limit bus
traffic or free up the I12C-bus master’s (MCU, MPU, DSP, chipset, etc.) timer. The uniqueness of this device is
the internal oscillator with two programmable blink rates. To blink LEDs using normal I/0 Expanders like the
PCF8574 or PCA9554, the bus master must send repeated commands to turn the LED on and off. This greatly
increases the amount of traffic on the [2C-bus and uses up one of the master’s timers. The PCA9553 LED
Blinker instead requires only the initial set-up command to program BLINK RATE 1 and BLINK RATE 2 (i.e,,
the frequency and duty cycle). From then on, only one command from the bus master is required to turn each
individual open drain output ON, OFF, or to cycle at BLINK RATE 1 or BLINK RATE 2. Maximum output sink
current is 25 mA per bit and 100 mA per package.

Any bits not used for controlling the LEDs can be used for General Purpose Parallel Input/Output (GP1O)
expansion.

USB-to-12C Elite - [PCA9553 4-bit LED Driver / Blinker] o S
H File Device Options Window Help = ||| =
LED Mode Select
LED 3 LED 2 LED 1 LED 0

PWM1 Rate PWM1 Rate PWM1 Rate PWM1Rate

PWMO Rate PWMO Rate PWMO Rate PWMO Rate

Off Off Off Off

Oon On On on
PWM 1 PWM O Registers (hex)

Period Duty Cycle Period Duty Cycle

I2C Address
O

Input Register

Frequency Prescaler 0

| Auto Write Off

PWM Register 0

Frequency Prescaler 1 Write All
PWM Register 1 Read Input
LED Selector 0-3 Read All
6.400 sec | 50.00% 6.400 sec |34.38 %
0.15625 0.15625
Hardware Detected 3.3V On 5.0V On 400 kHz

Device Address

The device 12C address can be selected by choosing one of the hexadecimal selections from the drop-down
list. The default address at start-up is 0xCO.

Auto Write On/Off Button

When Auto Write is disabled (LED off), the software can be modified without transmitting data to through the

parallel port. When the Auto Write LED is on, any changes made to the software is immediately transmitted
to the PCA9553.
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LED Mode Selector

Each LED can be set in one of four modes: ON, OFF, PWMO0, and PWM1. The mode is selected by moving the
switches to the appropriate mode for the LED. All LEDs set to PWMzx will blink at the same frequency, duty
cycle, and phase.

PWM Period Slidebar

The period of the PCA9553 can be changed by moving the PWMO or PWM1 slidebars. The period (in seconds)
and frequency (in Hertz) is displayed below the slidebar. The actual value of the PCA9553 register is
displayed in the Registers groupbox.

PWM Duty Cycle

The duty cycle for PWMO and PWM1 can be changed by moving the PWMO or PWM1 slidebars. The duty
cycle is displayed (in percent) below the slidebar. The actual value of the PCA9553 register is displayed in the
Registers groupbox.

Write All Button
Pressing the Write All button causes Registers 1 through 5 to be programmed.

Read Input Register
When the Read Input register button is pressed, the Input register is read, and the data is presented in the
Registers groupbox.

Read All Button

Pressing the Read All button will read all the device registers from the PCA9553 using the auto-increment
feature. Since the PCA955x devices don’t allow auto-increment starting from Register 0, the reads start with
the register with the highest address which causes the auto-increment pointer to roll-over to Register 0
(Input Register). The reads continue until the all the registers have been read.

The data will be displayed in the Registers groupbox and the controls (sliders, switches) will be updated.
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PCA9633 Four-bit 12C LED Dimmer

The PCA9633 is an I2C-bus controlled 4-bit LED driver optimized for Red/Green/Blue/Amber (RGBA) color
mixing applications. Each LED output has its own 8-bit resolution (256 steps) fixed frequency Individual
PWM controller that operates at 97 kHz with a duty cycle that is adjustable from 0 % to 99.6 % to allow the
LED to be set to a specific brightness value. A fifth 8-bit resolution (256 steps) Group PWM controller has
both a fixed frequency of 190 Hz and an adjustable frequency between 24 Hz to once every 10.73 seconds
with a duty cycle that is adjustable from 0 % to 99.6 % that is used to either dim or blink all LEDs with the
same value.

Each LED output can be off, on (no PWM control), set at its Individual PWM controller value or at both
Individual and Group PWM controller values. The LED output driver is programmed to be either open-drain
with a 25 mA current sink capability at 5 V or totem-pole with a 25 mA sink, 10 mA source capability at 5 V.
The PCA9633 operates with a supply voltage range of 2.3 V to 5.5 V and the outputs are 5.5 V tolerant. LEDs
can be directly connected to the LED output (up to 25 mA, 5.5 V) or controlled with external drivers and a
rPinimum amount of discrete components for larger current or higher voltage LEDs.

USE-to-12C Elite - [PCAD532 and PCAD633 Four-bit LED dimmer] =een X
H File Device Options Window Help — [ & =
Mode 1 = 0x91 PWM Registers Group Registers
. PWM3  PWMZ2  PWM1  PWMOD GRFPWM GRPFREQ
Auto-Increment: All registers 0x00 |0x00 |Ox00 | O0x00 0xFF 0x00
[#] Sleep enabled (oscilator off)
[7] Does not respond to subaddress 1 @ @ @ @ % @

[] Does not respond to subaddress 2
[] Does not respond to subaddress 3 S [ Y [ Y ) (Y I - ]
[¥] Responds to Al Call addresses

Mode 2 = 0x05

______ Group control = dimming - -t 1-1-1 [-1-] |-1-
[C] outputs not inverted

[] outputs changed on STOP ] || (= | =| = =]
[¥] Totem pole outputs (= = = (=) (= (=
OUTHNE 01 E| 0.00% | 0.00% | 0.00% | 0.00% 99.61% |0.04 sec
Subaddresses (SLUBADRx)
" o SUBADR1 E2 LR
LED Driver Qutputs (LEDOUT) = 0x00 i
I ] CUBADR? £a Device Address [&i]
LED3 is off =]
SUUBADRZ E& || Auto Write On
LED2 is off =]
ALLCALLADR EO g
LED1 is off |E| Write All
Software Reset
LEDO is off =] o Read All
Hardware Detected 3.3V On 5.0V On 400 kHz
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SAA1064 Four-Digit LED-driver

The circuit is especially designed to drive four 7-segment LED displays with decimal point by means of
multiplexing between two pairs of digits. It features an [2C-Bus slave transceiver interface with the possibility
to program four different SLAVE ADDRESSES, a POWER RESET flag, 16 current sink

OUTPUTS, controllable by software up to 21 mA, two multiplex drive outputs for common anode segments, an
on-chip multiplex oscillator, control bits to select static, dynamic and blank mode, and one bit for segment
test.

USB-ta-12C Elite - [SAA1064 LED Driver] ==y X
% File Device Options Window Help = || &
Device Address Automatic Write Read and Write
0%70 IEI [¥] Aute Write On Read Status | [ Write All
Control Register Digit 1 Digit 2

Current {mA)

[ git 7 [ it 7
("] All segments on I Bit6 Il Bite
_ [Cleit s [lBits
| Digits 2 and 4 on [ git 4 [ it 4
["] Digits 1 and 3 on Bit 3 — Lo
1 Bit 2 L1Bit2
["] pynamic mode | [Tl git 1 [l it 1
[“Igit 0 "I git 0

Hardware Detected 3.3V 0On 5.0V On 100 kHz

L

Control Register

The Control Register is responsible for determining the mode of operation of the SAA1064. It can control
which digits are blanked, static versus dynamic operation, and the current supplied to the LEDs.

In order to change the value of the Control Register in the SAA1064, the state of the checkboxes in the Control
Register box on the screen can be toggled (checked/unchecked) and the slider can be used to change the
current sinking of the device.

The figure below shows the contents of the Control Register.

x|C6|C5/C4/C3|C2|C1|C0

C6=1 adds 12mA to segment output current

C5=1 adds 6mA to segment output current

C4=1 adds 3mA to segment output current

C3=1 all segment outputs are switched on for segment test
C2=0/1 digits 2 and 4 are blanked /not blanked

C1=0/1 digits 1 and 3 are blanked /not blanked

CO0=0 static mode (continuous display of digits 1 and 2)
CO0=1 dynamic mode (alternating display of digit 1 + 3 and 2 + 4)
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Automatic Write

If the Automatic Write is enabled (green), any changes to the SAA1064 Control Register or Digits will
immediately be sent via the I?C bus.

The data sent to the SAA1064 consists of a Start condition, the I>C address, Instruction byte, then the data for
the changed Control Register or Data byte, followed by the Stop condition. Therefore, a total of three bytes
will be sent any time a change is made, and Automatic Write is enabled.

Digits 1, 2,3,and 4

The SAA1064 can drive up to four 8-segment LEDs. The data for these digits is contained in four registers
within the SAA1064. In order to change the contents of these registers, you can click on the LEDs within the
Digit groupboxes. If an LED is on (light green), then the LED segment is on while a dark green LED causes the
LED segment to turn off. Changes in the on-screen LEDs are reflected in the hexadecimal values shown above
the on-screen LEDs.

If the Automatic Write is enabled (light green), any changes to the SAA1064 Control Register or LED Digits
will immediately be sent to the device through I?C bus.

Instruction Byte
The instruction byte is equivalent to a subaddress. The instruction byte is configured as shown below:

0/0/0|/0|0|SC/SB|SA

The bits SC, SB and SA of the instruction byte form a pointer and determine to which register the data byte
following the instruction byte will be written. All other bytes will then be stored in the registers with
consecutive subaddresses. This feature is called Auto-Increment (Al) of the subaddress and enables a quick
initialization by the master. The subaddress pointer will wrap around from 7 to 0.

The USB-to-12C software does not allow the user to modify the instruction byte. The software points to 00h
when the write button is pressed since it will be writing all the registers. When Automatic Write is enabled,
the instruction byte will point to the register that is affected by the changes. For example, if the user clicks on
Bit 5 in Digit 4, then the software will set the instruction byte to 04h for the write sequence.

Read Address

This box reflects the I2C address that is sent to the SAA1064 when a read operation is performed. The
contents of this box cannot be changed directly by the user but can only be changed by clicking on a different
address in the Device Address box.

Status Register

Only one bit is present in the status byte: the Power Reset flag. If the most significant bit is a logic ‘1’, this indicates the
occurrence of a power failure since the last time it was read out. After completion of the READ action, this flag will be set
to logic ‘0’. The LED beside the read button will illuminate if the Power Reset flag is set.

Read Status Button

When the Read Button is pressed, the contents of the Status Register are read from the SAA1064. The LED
beside the read button will illuminate if the Power Reset flag is set.

Write Button

When the Write Button is pressed, seven bytes are sent over the I?C bus, equivalent to the Address,
Instruction byte, Control byte, and then the four Digit bytes.
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Master Selector
PCA9541 2-to-1 12C Master Selector

The PCA9541 is a 2-to-1 [2C master selector designed for high reliability dual master 12C applications where
system operation is required, even when one master fails, or the controller card is removed for maintenance.
The two masters (e.g., primary and back-up) are located on separate 12C-buses that connect to the same
downstream I12C bus slave devices. I2C commands are sent via the primary or back-up [2C-bus and are used
to select one master at a time. Either master at any time can gain control of the slave devices if the other
master is disabled or removed from the system. The failed master is isolated from the system and will not
affect communication between the on-line master and the slave devices on the downstream I2C bus.

USB-to-12C Elite - [PCAG541 2-to-1 Master Selector] =20 X
H File Device Options Window Help =&
Device Register 0: IE Register 1: Control Register 2: Interrupt Status
Address ﬁ
OXED H
| BUSLOSTMSK | NTESTON | NMYTEST
| BUSOKMSK == TESTON | MYTEST
| BUSINITMSK | BUSINIT mm| BUSLOST
| INTINMSK = NBUSON | BUSOK
=] BUSON =| BUSINIT
m=| NMYBLIS | INTIN
| MYBUS
Write Write
Read Read Read
NMYBUS MYBUS Slave channel NBUSON BUSON Slave channel
1] 0 The master reading this combination has confrol of the bus. 0 0 off
1 0 The master reading this combination does not have control of the bus. 1 0 on
1] 1 The master reading this combination does not have control of the bus. 0 1 on
1 1 The master reading this combination has control of the bus. 1 1 off
Hardware Detected 3.3V 0On 5.0V On 100 kHz
Register 0: Mask Register
BT 3 7 £ 5 4 3 2 1 0
SYMBOL i a 0 ] b BUSLOSTMSK BUSORMEX BUSINITMSE INTENMEK

Register 0 has four bits that can be written either by pressing the Write button or by enabling the Auto Write
option and then pressing the checkbox type buttons.
The register can be read by pressing the Read button in the Register 0 groupbox.

Register 1: Control Register
BT 7 B 5 4 E] 2 1 | ]
EYMBOL NMYTESTOM MYTESTON ] BUSINIT HMYIOMOFF MY ONAOFF MNMYIERAS MY GRAS

Register 1 is the Control Register. This register contains seven bits that control which master has control of
the bus.

USB-to-12C Software User’'s Manual Page 64



The register can be written either by pressing the Write button or by enabling the Auto Write option and then
pressing the checkbox type buttons.
The register can be read by pressing the Read button in the Register 1 groupbox.

Register 2: Interrupt Status Register

BIT 7 B 5 4 3 2 | i o

BUSINIT l INTIM

SYMB0L MMYTEST MYTEST o o BUSLOST BUS0K

The PCA9541 provides 4 different types of interrupt:

1. To indicate to the former 12C-bus master that it is not in control of the bus anymore.

2. To indicate to the new 12C-bus master that:

- The bus recovery/initialization has been performed and that the downstream channel connection has been
done (built-in bus recovery/initialization active).

- A “bus not well initialized” condition has been detected by the PCA9541 when the switch has been done
(built-in bus recovery/initialization not active). This information can be used by the new master to initiate its
own bus recovery-initialization sequence.

3. Indicate to both 12C upstream masters that a downstream interrupt has been generated through the INT_IN
pin.

4. Functionality wiring test.

Bus control lost interrupt

When the upstream Master x takes control of the I2C-bus while Channel y was using the downstream channel
(upstream Channel x connected to the slave downstream channel), an Interrupt is generated to the upstream
Master y (INTy line goes LOW to let Master y know that it lost the control of the bus) immediately after
Master y has been disconnected from the downstream channel.

By setting the BUSLOSTMSK bit to 1 by Master y (Bit 3, Mask Register, Reg#00), the Interrupt is masked and
the upstream master that lost the 12C-bus control (Master y) does not receive an Interrupt (INTy line does not

go LOW).

Recovery/initialization interrupt

Before switching to the upstream Channel x, an automatic bus recovery/initialization can be performed by
the PCA9541. This function is requested by setting the BUSINIT bit to 1 by Master x (Bit 4, Control Register,
Reg#01). When the downstream bus has been initialized, an Interrupt to the upstream Channel x is generated
(INTx line goes LOW).

By setting the BUSINITMSK bit to 1 by Master x (Bit 1, Mask Register, Reg#00), the Interrupt is masked, and
the upstream Master x does not receive an Interrupt (INTx line does not go LOW).

When the automatic bus recovery/initialization is not requested, if the built-in bus sensor function (sensing
permanently the downstream I2C traffic) detects a non-idle condition (previous bus Channel y connected to
the downstream slave channel, was between a START and STOP condition), then an Interrupt to Master x is
sent (INTx line goes LOW). This Interrupt tells the new master that an external bus recovery/initialization
must be performed. By setting the BUSOKMSK bit to 1 by Master x (bit 2,

Mask Register, Reg#00), the Interrupt is masked, and the upstream Master x does not receive an Interrupt
(INTx line does not go LOW).

Downstream interrupt

An Interrupt can also be generated by a downstream device by asserting the INT_IN pin LOW. When INT_IN is
asserted LOW and if both INTINMSK bits are not set to 1 by Master x and Master y (bit 0,

Mask Register, Reg#00), INTO and INT1 both go LOW. By setting the INTINMSK bit to 1 by Master x and/or
the INTINMSK bit to 1 by MASTER y (Bit 0, Mask Register, Reg#00), the Interrupt(s) is (are) masked and the
corresponding masked channel(s) does (do) not receive an Interrupt (INTO and/or INT1 line does (do) not go
LOW).

Functional test interrupt

Master x can send an Interrupt to itself to test its own INTx wire or send an Interrupt to Master y to test its
INTy line. This is done by:
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- Setting the MYTESTON bit to 1 by Master x (bit 6, Control Register, Reg#01) to test its own INTx line.

- Setting the NMYTESTON bit to 1 by Master x (bit 7, Control Register, Reg#01) to test Master y INTy line.
Setting the MYTESTON and/or NMYTESTON bits to 0 by Master x will clear the Interrupt(s).

NOTE: Interrupt outputs have an open-drain structure. Interrupt input does not have any internal pull-up
resistor and must not be left floating (e.g., pulled high to VCC through resistor) in order to avoid any
undesired interrupt conditions.
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Multiplexer / Switches

The USB-to-12C software supports nine of the most common 12C multiplexers/switches.

File [Device | Options Window Help
EEPROM

I/0 Expanders

LED Blinkers and Dimmers
Master Selector (2-to-1 dermux)
Multiplexers,Switches PCAS540B 2-Channel Multiplexer

Mon-volatile Registers PCA9542A 2-Channel Multiplexer with Interrupt Logic
RAM / FRAM PCA9543A 2-Channel Switch with Interrupt Logic
Real Time Clocks PCASS44A 4-Channel Multiplexer with Interrupt Logic
Thermal Management PCASS45A 4-Channel Switch with Interrupt Logic

Universal Modes PCA9546A 4-Channel Switch
PCA9547 B-Channel Multiplexer
PCA9548A 8-Channel Switch
PCAS549 Octal Bus Switch

GPIO Control

Slave Device

Hardware Detected 3.3V0n 5.0V On
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PCA9540B/PCA9542A/PCA9544A/PCA9547

The PCA954x is a family of bi-directional translating multiplexers, controlled via the I2C bus. The SCL/SDA
upstream pair fans out to SCx/SDx downstream pairs, or channels. Only one SCx/SDx channel is selected at a
time, determined by the contents of the programmable control register. Interrupt inputs (not available in the
PCA9540), one for each of the SCx/SDx downstream pair, are provided. One interrupt output, which acts as an
AND of the four interrupt inputs, is provided. All [/O pins are 5 V tolerant.

The pass gates of the multiplexer are constructed such that the Vdd pin can be used to limit the maximum
high voltage that will be passed by the PCA954x. This allows the use of different bus voltages on each
SCx/SDx pair, so that 3.3V parts can communicate with 5V parts without any additional protection. External
pull-up resistors can pull the bus up to the desired voltage level for this channel.

i N
USB-to-12C Elite - [ PCAGS40B / PCAS542A f PCAS5444A / PCASSAT FC Multiplexers] S e S
& File Device Options Window Help - & x
PCAS540B PCASS42A PCASS4A4A PCASS47
Device Address  |OxED Device Address OxED |E| Device Address OxEQ |E| Device Address OxEQ E|
Control Register Control Register Control Register Control Register
Write Write Write Wirite
Read Read Read Read
Channel Select Channel Select Channel Select Channel Select
@ Mo channel @ No channel @ No channel @ Mo channel
Channel 0 Channel 0
- Channel 0 Channel 0 Channel 1 ) Channel 1
Channel 1 Channel 1 -/ Channel 2 Channel 2
Channel 3 Channel 3
Interrupts Interrupts Channel 4
mm| Channel 0 i g:anne: T ' Channel 5
anne
| Channel 1 ‘| Channel 2 Channel &6
| Channel 3 Channel 7
[¥] Aute Write On [¥] Aute Write On V| Auto Write On [¥] Auto Write On
Hardware Detected 3.3¥ On 5.0V On 400 kHz

Control Register

This register selects the active multiplexer channel as well as indicating any interrupting inputs.

The control register edit box is read-only. The contents of the control register can be changed by selecting a
new channel in the Channel Select box or reading the status with the Read Button.

Interrupts

The PCA9544 and PCA9542 provide interrupt inputs; one for each channel and one open drain interrupt
output. When an interrupt is generated by any device, it will be detected by the PCA954x and the interrupt
output will be driven LOW. The channel need not be active for detection of the interrupt. A bit is also set in
the control byte. Bits 4 - 7 of the control byte correspond to channels 0 - 3 of the PCA9544, respectively,
while bits 4 and 5 are used by the PCA9542. Therefore, if an interrupt is generated by any device connected to
channel 2, and then bit 6 will be set in the control register. Likewise, an interrupt on any device connected to
channel 3 would cause bit 7 of the control register to be set. The master can then address the PCA954x and
read the contents of the control byte to determine which channel contains the device generating the
interrupt.

The master can then reconfigure the PCA954x to select this channel, and locate the device generating the
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interrupt and clear it. The interrupt clears when the device originating the interrupt clears.
It should be noted that more than one device could be providing an interrupt on a channel, so it is up to the
master to ensure that all devices on a channel are interrogated for an interrupt.

Multiplexer Control
The user can change the selected channel by clicking the appropriate radio button. At start-up, no channel is
selected.

Auto Write

When the Auto Write On is enabled (illuminated), any changes made by the user to the PCA954x channel
selection radio buttons will immediately be sent to the device via the I°C bus.
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PCA9543A/PCA9545A/PCA9546A/PCA9548A/PCA9549

The PCA9543/9545/9546/9548 is a family of bi-directional translating switches, controlled via the I>C bus.
The SCL/SDA upstream pair fans out to SCx/SDx downstream pairs, or channels. Multiple SCx/SDx channels
may be selected at a time, determined by the contents of the programmable control register. Interrupt inputs,
one for each of the SCx/SDx downstream pair, are provided in the PCA9543 and PCA9545. One interrupt
output, which acts as an AND of the four interrupt inputs, is provided. The interrupt inputs can also be used
as general purpose inputs. All [/0O pins are 5V tolerant.

The pass gates of the switches are constructed such that the Vdd pin can be used to limit the maximum high
voltage that will be passed by the PCA954x, enabling these devices to be used as voltage translators

-

USE-to-12C Elite - [PCAD543 / PCAG545 f PCAGS46 f PCASS48 / PCADS49 Switches] o S
& File Device Options Window Help - | 5| =
PCAS543A PCAS545A PCASS46A PCA9548A/PCAS549
Device Address OxEZ2 E Device Address OxED |E| Device Address OxED |E| Device Address OxED
Control Register Control Register Control Register Control Register
Write Write Write Write
Read Read Read Read
Channel Select Channel Select Channel Select Channel Select
| Channel 0 [ channel 0 ] Channel 0 || Channel 0
| Channel 1 | Channel 1 | channel 1 | Channel 1
| Channel 2 | Channel 2 || Channel 2
| Channel 3 | channel 3 | Channel 3
Interrupts Interrupts | Channel 4
== Channel 0 .| Channel 0 | Channel 5
| Channel 1 | Channel 1 || Channel &
| Channel 2 | Channel 7
| Channel 3
[¥] Auto Write On [¥] Auto Write On [¥] Auto Write On
Hardware Detected 3.3V On 5.0V On 400 kHz

L

Control Register

This register selects the active switch channel(s) as well as indicating any interrupting inputs.

Selecting a new channel in the Channel Select box or reading the status with the Read Button can change the
contents of the control register.

Interrupts

When an interrupt is generated by a downstream device, it will be detected by the PCA954x and the interrupt
output will be driven LOW. The channel need not be active for detection of the interrupt. Interrupts are
indicated with an illuminated LED on the screen. The interrupt bits are read-only.

Channel Selection
The user can change the selected channel(s) by clicking the appropriate checkboxes in the Channel Select box.
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Auto Write

When the Auto Write On is enabled (checked), any changes made by the user to the PCA954x channel
selection radio buttons will immediately be sent to the device via the I?C bus. If not checked, the write button
will need to be pressed before the data is sent to the PCA954x.
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Non-volatile Registers
PCA8550/PCA9559/PCA9560/PCA9561

UUSB-to-I2C Elite - [PCAB550 / PCAS559 / PCA9560 / PCASSEL Non-volatile Registers] = -
H File Device Options Window Help - || 5| =
PCAB550 PCASSG0 PCASS61
Device Address | 9C 2C Address 0x9a E| I12C Address 093 |z|
Data Byte 0o
fion-muxed data? [ EEPROM Byte 0 |EEPROM Byte 1 EEPROM Byte 0 EEPROM Byte 1
Mux Data D ] FF FF FF FF
Mux Data C . __ Write Read Write Read
Mux Data B 1 Write EEQ Write EE1
— FEPROM Byte 2 FEPROM Byte 3
Write Read Read EEQ Read EE1 o =
= ;
(L Sk e OO Write Al Read All Write Read Write || Read
PCA9559
I2C Address 0x98 |~
Data Byte 00

Mon-muxed data

Mux Data E [ Mux In - Read Mux Mux In - Bead Mux

Mux Data D 1
Mux Data C (4] MUX_OUT from EEPROM 0 E| MU¥_IN or non-volatile Reqister 0 E
Mux Data B is sourced to MUX_OUT
Mux Data A | Write Write
Write Read
[¥] Auto Write On
Hardware Detected 3.3V On 5.0V On 400 kHz

Address Selection

A drop-down address selection is available which can be used to change the I?C address of the PCA9559,
PCA9560, and PCA9561. Note that the PCA8550 does not have a programmable 12C address as it is fixed at
0x9C.

Data Register

Clicking on the checkboxes will change the state of the non-volatile register. If the state of the checkbox is
changed while ‘Automatic Write’ is enabled (checked), then the data will immediately be sent to the target
device. If ‘Automatic Write’ is disabled (unchecked), then the Write button must be pressed to send the I*C
message to the target device.

EEPROM Byte x

The PCA9560 and PCA9561 contain EEPROM data bytes that can be programmed by USB-to-12C. Enter a
hexadecimal number into each of the edit boxes and then press the Write EEx button to program the
EEPROM. The value of the EEPROM can be read by pressing the Read Eex button.

MUX_OUT

The MUX_OUT pins can be set to the values in the EEPROM or from the MUX_IN pins by selecting the desired
state from the drop-down combo box.
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Auto Write

When Auto Write is enabled (green), any changes made by the user to the devices will immediately be sent to
the device via the I?C bus. If not checked, the write button will need to be pressed before the data is sent to
the device.
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Real-time Clocks
PCF8563

The PCF8563 is a CMOS real time clock/calendar optimized for low power consumption. A programmable

clock output, interrupt output and voltage-low detector are also provided. All address and data are

transferred serially via a two-line bidirectional 12C-bus. Maximum bus speed is 400 kbit/s. The built-in word

address register is incremented automatically after each written or read data byte.

USE-to-12C Elite - [PCFE563 Real time clock/calendar] =eEn X
ﬁ File Device Options Window Help =[]
Name Value Cor]HE_I_{I'Status 1 Clock Time Clock Date
00 control/status 1 00 srf'g; Hour Min. Sec Month Day Year
01 control/status 2 00 E E m
02 seconds 16 Ul m - = =
03 minutes 37 Control/Status 2 — w v v
04 hours 17 TI/TP [ o
05 day 09 AF [l Read Time | Cydlic Read Start w
06 weekdays 07 TF [l
07 month/century 0z AIE La ] )
08 years 13 TIE i Clock integrity Read Date
09 minute alarm 80 CLKOUT control TR R
0A hour alarm g0 Frequency Set Alarm Time Alarm Date
0B day alarm 89 :
0C weekday alarm a7 == EE K E' o sl o
0D CLKOUT control g0 CLEOUT active ] m E v
DE timer control 03 ) ~ PY
OF |timer FE Timer Control L ¥
Active Register = 0x00 Countdown Frequency 3
Read Register Write Register 1/60 Hz IEI Minute Alarm Disabled J
_ Timer Disabled —  Hour Alarm Disabled ¥
Read All Write All Day Alarm Disabled J
| Auto Write Reset Timer {hex) FF Weekday Alarm Disabled [V
Hardware Detected 3.3V On 5.0V On 400 kHz
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Thermal Management

The USB-to-12C software supports seven of the common thermal management 12C devices.

File [Device | Options Window Help
EEPROM

I/0 Expanders

LED Blinkers and Dimmers
Master Selector (2-to-1 dermux)
Multiplexers,Switches
Mon-volatile Registers

RAM / FRAM

Real Time Clocks

Thermal Management LM754 Digital Ternperature Sensor

Universal Modes LMT75B Digital Temperature Sensor

MELE17(A) Temperature monitor

5A56004 1°C Digital Temperature Sensor

SE97 DDR Memory Maodule Ternperature Sensor with SPD
SE97E DDR Memory Module Ternperature Sensor with SPD
SE98(A) 50-DIMM Temperature Sensor

GPIO Control

Slave Device

Hardware Detected 3.3V0n 5.0V On
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LM75A Digital temperature sensor and thermal watchdog

The LM75A is a temperature-to-digital converter using an on-chip band-gap temperature sensor and Sigma-
delta A-to-D conversion technique. The device is also a thermal detector providing an over-temp detection
output. The LM75A contains a number of data registers: Configuration register (Conf) to store the device
settings such as device operation mode, OS operation mode, OS polarity and OS fault queue; temperature
register (Temp) to store the digital temp reading, and set-point registers (Tos & Thyst) to store
programmable over-temperature shutdown and hysteresis limits, that can be communicated by a controller
via the 2-wire serial I2C-bus interface. The device also includes an open-drain output (0OS) which becomes
active when the temperature exceeds the programmed limits. There are three selectable logic address pins
allowing eight devices can be connected on the same bus without address conflict.

USB-to-12C Elite - [LM75A/LM75B Digital Temperature and Thermal Watchdog] =TC00 X
H File Device Options Window Help = | &
Device Address Automatic Write Read and Write All Registers
e [v] Read Al Write Al
Temperature
Temp Register Temperature
I 030000 XX °C
Hysteresis register (Thyst)
Thyst Register Thyst
Read Write o 0x4B00 75.0°C
Overtemp shut-down threshold (TOS)
TOS Register TOS
Read Wit
- — S ox5000 80.0°C
Configuration Register
Configuration
Read Write Ox00
Shut-down Mormal E| 0S Polarity Low E|
0S Mode Comparator EI 0S Fault Queue 1 |E|
Hardware Detected 3.3V On 5.0V On 100 kHz

Device Address
A drop-down menu is provided which allows the user to select a valid address for the selected device type.

Automatic Write (Checkbox)

When this item is enabled (indicator shown in green), any changes to the Thyst, TOS, or Configuration
Register will immediately be sent to the LM75A.

Write All

Pressing this button will send data to the Thyst, TOS, and Configuration Registers.

Read All

Pressing this button will read all the registers in the LM75A.
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Temperature Register (Temp)

The Temp register holds the digital result of temperature measurement at the end each A-to-D conversion.
This register is read only and contains two 8-bit data bytes consisting of one most significant (MS) data byte
and one least significant (LS) data byte. However, only 11 bits of those two bytes are used to store the Temp
data in 2’s complement format with the resolution of 0.125°C

Notice that when the Temp registers are read, all 16 bits are provided to the bus and must all be collected by
the controller to complete the bus transaction. However, only the 11 most significant bits should be used, and
the 5 LSB bits of the LS byte are zero and should be ignored.

Thyst (Hysteresis) Register

The Thyst register defines the hysteresis for the device Watchdog operation. At the end of each conversion
the Temp data will be compared with the data stored in this register.

The Thyst register contains two 8-bit data bytes consisting of one MS data byte and one LS data byte the same
as the Temp register. However, only 9 bits of the Thyst register are used to store the set-point data in 2’s
complement format with the resolution of 0.5°C.

The Thyst Register data may be changed by pressing the up/down arrows and then pressing the Write
button. The data can also be sent automatically by pressing the up/down arrow while the Auto Write
checkbox is checked.

TOS (Overtemp shut-down threshold) Register

The TOS register is used to store the user-defined overtemp shut-down threshold (Tos) for the device
Watchdog operation. At the end of each temperature conversion the Temp data will be compared with the
data stored in this register in order to set the state of the device OS output.

The TOS register contains two 8-bit data bytes consisting of one MS data byte and one LS data byte the same
as the Temp register. However, only 9 bits of the two bytes are used to store the set-point data in 2’s
complement format with the resolution of 0.5°C.

The TOS Register data may be changed by pressing the up/down arrows and then pressing the Write button.
The data can also be sent automatically by pressing the up/down arrow while the Auto Write checkbox is
checked.

Configuration Register
The Configuration register is a write/read register and contains an 8-bit non-complement data byte that is
used to configure the device for different operation conditions. The Configuration register table shows the bit
assignments of this register.
Bit Name R/W | POR Description

B7-B5 | Reserved R/W | 000 | Reserved for the manufacturers use.

B4-B3 | OS Fault Queue R/W 00 | For OS Fault Queue programming.
Programmable queue data = 0, 1, 2, 3 for queue value
=1, 2, 4, 6 respectively. Default = 0.

B2 0S Polarity R/W 0 For OS Polarity selection.
1 = 0S active HIGH, 0 = OS active LOW (default).
B1 0S R/W 0 For OS operation Mode selection.
Comp/Interrupt 1 = OS interrupt, 0 = OS comparator (default).
BO Shut-down R/W 0 For Device Operation Mode selection.

1 = Shut-down, 0 = Normal (default).

Start Read Button

The temperature data can be continuously read by pressing the Start Read button. The time elapsed between
each successive read transmission can be programmed by changing the value in the box above the Start Read
button. The temperature history is displayed in the graph above the button.

USB-to-12C Software User’'s Manual Page 77



NE1617(A) Temperature monitor

The NE1617A is an accurate two-channel temperature monitor. It measures the temperature of itself and the
temperature of a remote sensor. The remote sensor is a diode connected transistor.

-

-
USB-to-12C Elite - [NE1617(A) Temperature Monitor] =H0CT X
File Device QOptions Window Help
Device Address RIT Register (0c00)=0x00 RET Register (0x01)=0x00 RCR Register (0x04)=0x02
0x30 E Internal Temp = 127°C External Temp = 0°C Conversion rate = 0,25 Hz
Status Byte (0x02) = 0x00 Read Read Read
|| ADC not busy
_|Int high temp not tripped RIHL Register (0x05)=0x7F REHL Register (0x07)=0x7F WCR Register (0x0A)
Lal ) Sl me idl e Int High Temp Limit=127°C Ext High Temp Limit=127°C
il Ext high temp not tripped 0.2500 Hz |z|
|| Ext low temp not tripped Read Read
| External diode not open
Read RILL Register (0x06)=0xC9 RELL Register (0x08)=0xC9
- Int Low Temp Limit=-55°C Ext Low Temp Limit = -55°C One Shot
RC Register (0x03)=0x00
' Alert interrupt enabled St P Read All
|| Running mode
Write All
Read Set Int Temp Limits (°C) Set Ext Temp Limits (°C)
WC Register (0x09)=0x00 WIHL (0x0B) 127 = WEHL (0x0D) 127 2 Automatic Write
[T] alert interrupt enabled = =
S WILL (0x0C)  -55 = WELL (Ox0E)  -55 |- [ #ut
|| Running mode enabled
Hardware Detected 3.3V On 5.0V On 100 kHz

e

Read-Only Registers

The following data registers can be read by USB-to-12C:
0x00 RIT Read Internal Temperature

0x01 RET Read External Temperature

0x02 Status Byte

0x03 RC Read Configuration

0x04 RCR Read Conversion Rate

0x05 RIHL Read Internal High Limit Temperature
0x06 RILL Read Internal Low Limit Temperature
0x07 REHL Read External High Limit Temperature
0x08 RELL Read External Low Limit Temperature

Write Only Registers

The following data registers can be written to by USB-to-12C:
0x09 WC Write Configuration Register

0x0A WCR Write Conversion Rate Register

0x0B WIHL Write Internal High Limit Temperature

0x0C WILL Write Internal Low Level Temperature

0x0D WEHL Write External High Level Temperature

0x0E WELL Write External Low Limit Temperature

Auto Write
The Write-Only registers can automatically be sent to the NE1617 upon changing the on-screen state when
this function is enabled.
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SA56004A Temperature Sensor

The SA56004X is an SMBus compatible, 11-bit remote/local digital temperature sensor with over
temperature alarms. The remote channel of the SA56004 monitors a diode junction, such as a substrate PNP
of a microprocessor or a diode connected transistor such as the 2N3904 (NPN) or 2N3906 (PNP). With

factory trimming, remote sensor accuracy of +1°C is achieved.

Under and over temperature alert thresholds can be programmed to cause the ALERT output to indicate
when the on-chip or remote temperature is out of range. This output may be used as a system interrupt or
SMBus alert. The T_CRIT output is activated when the on-chip or remote temperature measurement rises
above the programmed T_CRIT threshold register value. This output may be used to activate a cooling fan,
send a warning or trigger a system shutdown. To further enhance system reliability, the SA56004X employs a

SMBus time-out protocol.

-

U5B-to-12C Elite - [SA560044A Temperature Sensor]

HEiIe Device Options Window Help

Device Address

o8 [v]

Status Register=0x00 LTHE=0x00

| ADC not busy Read
| Int high temp not tripped
| Int low temp not tripped
il 7] Ext high temp not tripped
| Ext low temp not tripped
| Bxternal diode not open

| Remote Mot Critical Temp
[ Local Mot Critical Temp
Read LLS Ox0 .

Local Temperature (*C)

Local Temperature=70°C

LTLB=0x00

Local Temp Limits (°C)
Local HIGH Setpoint = 70°C
LHS 0x46 =

-

Local LOW Setpoint = 0°C

Configuration = 0x00 Write Read
[] Alert interrupt enabled
| Running mode

Local T_CRIT (°C)

T_CRIT Hysteresis

] Remote T(crit) Enabled T_CRIT=85"C Hysterasis=10°C T_CRIT=85"C
| Local T(crit) Enabled LCS 0x55 = TH OxA = RCS 0x55 =
|| Fauk Queue: single
Write Read Write Read Write Read Write Read
Conversion Rate (CR) Remote Temperature Offset (°C)
Wit Read D RMID = (XX ==
operes E rite RDR = 0xXX p— Remote Temp Offset=0°C
Read Cne Shot RTOHB 0Ox0 = RTOLB 0x0 =
Cyclic Read
Automatic Write :
1 || Interrupt Mode e fcad
Hardware Detected 3.3V On 5.0V On 100 kHz

Remote Temperature (°C)
Remote Temperature=0°C
RTHB=0x00 RTLB=0x00
Read
Remote Temp Limits (°C)
Remote HIGH Setpoint = 70°C

RHSHB 0x46 £ RHSLB Ox0 =

Remote LOW Setpoint = 0°C
RLSHB 0x0 = RLSLB 0x0 =
Write Read

Remote T_CRIT (°C)
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SE98 Temperature Sensor

The SE98 is a JEDEC compliant local temperature sensor specifically designed for higher performance SO-
DIMM applications. The temperature sensor is mounted on the SO-DIMM module and communicates with the
processor via the 12C-bus/SMBus. Since the DRAM refresh rate is dependent on temperature, mounting the

temperature sensor on the module allows the processor to adjust the refresh rate based on the actual

temperature instead of the calculated worst-case temperature.
The SE98 consists of a AZ A-D converter that continuously monitors and updates its own temperature
readings, converts the reading to digital data, and registers into the data temperature register. The data is
compared to three alarm registers which are programmed and read via a 2-wire serial bus (SMBus, 12C-bus
Standard-mode and [2C-bus Fast-mode). The device also supports the SMBus time-out function that prevents

system lock-ups.

Device Address

B 7]

Configuration=0x0000
Disable hysteresis

Temp sensor on

[W] Crit. trip register not locked
Alarm Window not locked
[® Event not cleared

[E EVENT not asserted

Temperature Reqgister

| Temperature=20.00°C
Temperature Register=0x0000

CacTt [Oaaw  [CBaw

Read Cyclic Read

Upper Boundary Alarm Trip (°C)

= 0.00 =C

I ]

UBAT = 0x0000

Write Read

SMBus Reqgister

[E] 5MBus time-out enabled
[@] SMBus alert enabled

Write Read

r ™

E File Device Options Window Help

Manufacturer ID=0m0000(
Read

Device ID=0:00K

EVENT output disabled Read
W Alarm or Critical Event Lower Boundary Alarm Trip (°C)
[ EVENT output active low | =
i e Lol lea Tl Automatic Write
W Comparator Mode LBAT = Ox0000
Cn
Write Read Write Read
Capability = 0x3000K Critical Afarm Trip (®C)
=] TRES = wRNG EE 0.00 °C
=
ey & Beap CAT = 0x0000 Virite Al Read All
Read Write Read
Hardware Detected 3.3V 0On 5.0V On
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Slave Mode

The slave mode is only available in the USB-to-12C Elite and Ultra hardware.
The Slave Mode interface allows the user to configure the hardware as an I2C slave. It also shows the contents
of the slave’s data buffer.
When the slave interface starts, the hardware will normally be in master mode until the slave interface has

been configured. Note that it is not necessary to change the I°C frequency. The frequency is only applicable
in master mode. In slave mode, it will automatically synchronize to the master’s frequency.

-

USB-to-12C Elite - [I°C Slave Control] = | |

HE“E Device QOptions Window Help = || =
00 01 02 03 04 05 06 07 08 09 OA OB OC OD OE OF
00 FF |[FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
EnableSlave | a0 |lg1 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
02 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
Define Slave Size | 256 |\o@ \FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
04 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
Fill Slave Buffer  FF g5 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
06 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
e ke Bl 07 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
O8 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
ldle Slave 09 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
OA FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
AT OB FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
OC FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
Rl oSt OD FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
OF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
st OF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF

Firmware version 2.3 or later is required for Slave Contral
Hardware Detected 3.3¥0On  5.0¢On 100 kHz
L
Write to Slave

The slave responds to standard I°C messages that would be used to communicate with memory devices like
static RAMs and eeproms. A write to the slave, via the 12C bus, can be accomplished by sending a sequence of

bytes as shown here.

Acknowledge

Acknowledge

Acknowledge

Start

from Slave froum Slave from Slave
Address Subaddress Data
W nBytes Stop
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The slave will acknowledge its address after it has been enabled (see Enable Slave paragraph below). The
subaddress (or byte address) is a pointer to one of the 256 bytes in the slave data buffer. The I°C master will
then write any number of bytes to the slave. The byte pointer is incremented after each byte has been written
to the slave. The data sent to the slave will wrap back to byte address 0 if it exceeds the maximum size of the
slave (see Define Slave Size below).

Read from Slave
A read from the slave via the 12C bus can be accomplished by sending the following sequence of bytes:

Acknowledge Acknowledge Acknowledge  {Ho) Acknowledge
from Slave from Slave from Slave from Master

Address | ESUIM(I{IH&H# Address | {Dﬂtn F
Start W ReStart R nBytes Stop

The slave will acknowledge its address after it has been enabled (see Enable Slave paragraph below). The
subaddress (or byte address) is a pointer to one of the 256 bytes in the slave data buffer. The I?C master can
then send a Stop, followed by a Start, or it can send a Restart. The master can then read from 1 to any number
of bytes from the slave. The byte pointer is incremented after each byte is read from the slave. The data sent
to the master will wrap back to byte address 0 if it exceeds the maximum size of the slave (see Define Slave
Size below).

Enable Slave

Set the desired slave address into the edit box and press the Enable Slave button. This will start the slave
process and the slave will begin acknowledging its slave address. The hardware will no longer be capable of
sending [2C messages and will only operate as a slave on the bus.

Define Slave Size

At start-up, the slave is initialized as a 256 byte device. This value can be set from a minimum of 1 to a
maximum of 256 bytes.

Changing the slave size determines how it saves data in its memory. For example, if the slave is defined as a
16 byte device, after byte address 0x0F has been written or read, via the 12C bus, any additional bytes
written/read will wrap to address 0x00.

Fill Slave Buffer

Pressing the Fill Slave Buffer button will initialize the entire 256 bytes in the 12C slave with the hex data the
user has entered in the edit box located beside the Fill Slave Buffer button.

Read Slave Buffer

The contents of the slave’s buffer can be read by pressing Read Slave Buffer button. The contents of the
slave’s buffer will be displayed in the grid.

Idle Slave
It is possible to temporarily “remove” the slave from the bus by using the Idle Slave button. When the slave
has been idled, it will not acknowledge its address.

Resume Slave
A slave which has been idled will begin acknowledging its address after the Resume Slave button is pressed.
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Enable Master
If the hardware is functioning as an 12C slave, it can be converted back to a master by pressing the Enable
Master button. If the Enable Master button is pressed, it will not acknowledge its [2C address.

Close
Press the Close button when done using the hardware as an 12C slave. It will close the slave interface and
convert the hardware back into an I2C master.
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TROUBLESHOOTING

. If you have problems with the software installation, ensure that you have Admin
Privileges.

. The Adapter has 3.3kQ pull-up resistors to 3.3V on the I2C bus lines. Ensure that
additional pull-up resistors in the user target system do not bring the pull-up
resistance below 1.6kQ for 5V systems or 1.1KQ for 3.3V systems. The on-board pull-
up resistors can be removed from the system by removing the pull-up resistor
jumpers RPU (see Hardware Description above).

. The USB-to-12C software will not function on Windows 95, Windows 98 (First
edition), or NT systems; therefore, installation will not proceed if you attempt to
install the software on these Operating Systems.

. The USB-to-12C software requires that Microsoft GDI+ is installed on your PC. Itis
normally installed by Windows, however, if you receive an error message saying that
the GDI dll is missing, you can download it from the Microsoft website:

Microsoft GDI+ download

. USB-to-12C hardware monitors the communications on the I2C bus for proper
operation of connected peripherals; any errors on the bus are detected and reported
by the software. Bus communication is stopped if errors are detected and can be
resumed when the (hardware) problem is corrected and the transmission retried.

. Keep a copy of the original USB-to-12C installation file in the event the software needs
to be re-installed. Future USB-to-12C software updates from our website may require
a previous installation from the original media.

= Check for new versions of the software at https://www.i2ctools.com /manuals-and-

downloads/

. The firmware for the Professional, Elite, and Ultra hardware can be upgraded by the
user, if the firmware loaded on the Elite hardware is version 2.0 or later, and the
hardware for USB-to-12C Professional is 3.0 or later. We will also upgrade the
firmware for you if you have an earlier revision. The hardware will need to be
returned to us for version 1.x. Please visit the i2ctools website to find the latest
firmware information.

If all else fails, email a description of the problem you are having to us at
support@i2ctools.com.
Note that all technical support requests must begin with an email to this email address.
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We are interested in receiving feedback from our customers. Is there is a feature that
should be added to make this tool better? Please send your requests and comments to
support@i2ctools.com.
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